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About SolarWinds 

SolarWinds, Inc develops and markets an array of network management, monitoring, and 
discovery tools to meet the diverse requirements of today‟s network management and consulting 
professionals. SolarWinds products continue to set benchmarks for quality and performance and 
have positioned the company as the leader in network management and discovery technology. 
The SolarWinds customer base includes over 45 percent of the Fortune 500 and customers from 
over 90 countries. Our global business partner distributor network exceeds 100 distributors and 
resellers. 

Contacting SolarWinds 

You can contact SolarWinds in a number of ways, including the following: 

Team Contact Information 

Sales 1.866.530.8100 
www.solarwinds.com  

Technical Support www.solarwinds.com/support  

User Forums thwack.com 

 

Conventions 

The documentation uses consistent conventions to help you identify items throughout the printed 
and online library. 

Convention Specifying 

Bold Window items, including buttons and fields. 

Italics Book and CD titles, variable names, new terms 

Fixed font  File and directory names, commands and code examples, 
text typed by you 

Straight brackets, as 
in [value] 

Optional command parameters 

Curly braces, as in 
{value} 

Required command parameters 

Logical OR, as in 
value1|value2 

Exclusive command parameters where only one of the 
options can be specified 

 

 

 

 

 

 

http://www.solarwinds.com/
http://www.solarwinds.com/support
http://www.thwack.com/
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Orion Network Configuration Manager Documentation 
Library 

The following documents are included in the SolarWinds Orion Network Configuration Manager 
documentation library: 

Document Purpose 

Administrator Guide Provides detailed setup, configuration, and conceptual 
information. 

Quick Start Guide Provides installation, setup, and common scenarios for 
which Orion Network Configuration Manager provides a 
simple, yet powerful, solution. 

Release Notes Provides late breaking information, known issues, and 
updates. The latest Release Notes can be found at 
www.solarwinds.com.  
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Chapter 1 

Introduction 

SolarWinds Orion Network Configuration Manager streamlines and automates 
network configuration management. Orion Network Configuration Manager 
increases availability, saves time, improves security, and ensures policy 
compliance. Orion Network Configuration Manager features automation 
capabilities that reduce the amount of time network engineers spend on 
mundane network tasks, allowing them to focus on business-critical network 
projects. 

Key Features of Orion Network Configuration Manager 

Orion Network Configuration Manager offers the following features: 

Scheduled Configuration Backups 

You can schedule configuration downloads, configuration uploads, device 
reboots, command scripts execution, and more. In addition, configuration 
backups are stored both in a relational database for archival history and as 
flat files in an intuitive folder structure for easy viewing. 

Policy Management 

You can ensure device compliance with federal regulations, as well as 
corporate standards. The Policy Reporting Manager comes with several out-
of-the-box policy reports, including SOX, HIPAA, CISP, and Cisco Security. 
For more information, see Chapter 10 of the Orion NCM Administrator‟s 
Guide. 

Role-Based Access Control 

You can integrate your Windows Active Directory or local system user 
accounts with Orion Network Configuration Manager. You can manage users 
based on their role and establish individual device login credentials per user. 
Orion Network Configuration Manager logs all user activity allowing you to 
keep an archive of changes and activity. For detailed steps, see Error! 
Reference source not found. 

Multivendor Support 

You can monitor network devices from multiple hardware vendors. As a 
monitor and manager of routers, switches, firewalls, VPN concentrators, 
wireless access points and more, Orion Network Configuration Manager is a 
robust solution that is fully capable of managing your hybrid vendor network. 
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Bulk Changes 

Across many devices you can quickly make changes to community strings, 
passwords, and black lists. With Orion Network Configuration Manager, you 
can execute bulk changes either in real-time or within a scheduled change 
window. Uploads, changes, and global command scripting can be scheduled 
by device type, physical location, by owner, or by any custom property you 
create. For more information, see Chapter 6 of the Orion NCM 
Administrator‟s Guide. 

Configuration Change History 

You can receive reports on what devices have had configuration changes 
over any time period you specify. Configuration change reports can also 
compare current configurations with a baseline configuration alerting you 
whenever a change is discovered. For detailed information, see “Running 
Change Reports” and “Comparing Configurations” in Chapter 4 of the Orion 
NCM Administrator‟s Guide. 

Web-Based Configuration Viewing, Tracking, and Comparing 

Manager remotely view, track changes, and compare network device 
configurations without logging on to the physical Orion Network Configuration 
Manager server. The Orion NCM Web Console offers these powerful 
functions to the users you select. 

Orion Core Integration 

With version 7.0 NCM is fundamentally integrated with Orion Core 
components. Through the Orion Web Console you can: 

¶ Add and Manage Orion and NCM Devices 

¶ Synchronize Orion and NCM Databases 

¶ Search Configurations 

¶ Compare Configurations 

¶ Refresh Device Inventories  

¶ Group and View Inventory Reports  

¶ Create and Manage Policy Reports  

¶ Generate and Review Switch Port Maps 

¶ Perform an End Host Search 

¶ View Recent Configuration Changes 

¶ View Node Configuration History 
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¶ View Last 10 Config Changes 

¶ Last XX Configurations 

Orion Alerts Integration 

With the Orion NCM integration module you can use a default NCM alert in 
the Orion Alert Manager; and you can specify NCM actions to run when this 
alert triggers, viewing the results of those actions along with the notification. 
For details, see Chapter 13 of the Orion NCM Administrator‟s Guide. 

Device Configuration Change Templates 

You can use templates to generate an appropriate sequence of CLI 
commands for all relevant devices for which you need to make a specific 
configuration change. For details, see Chapter 7 of the Orion NCM 
Administrator‟s Guide. 

Device Configuration Change Control 

You can use an email-based approval system to supervise what changes are 
made to network devices. For details, see Chapter 13 of the Orion NCM 
Administrator‟s Guide. 
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Chapter 2 

Installing Orion Network Configuration 
Manager 

Orion Network Configuration Manager provides a wizard-driven installation 
process.  

Requirements 

The requirements for Orion Network Configuration Manager vary based on a 
number of factors, including the following: 

¶ The number of nodes 

¶ The frequency of configuration downloads 

¶ The length of time that configurations are maintained in the database 

The following table provides the general requirements for an Orion Network 
Configuration Manager installation. 

Software/Hardware Requirements 

Operating System Windows 2003 Server SP2 or later (32-bit and 64-bit) including R2, 
with IIS installed and running in 32-bit mode. Windows 2008 Server 
Enterprise or Standard (32-bit or 64-bit) including R2, with IIS installed 
and running in 32-bit mode. 

Note: SolarWinds does not support installation of Orion NCM on 
Windows XP, Vista, or 7 in production environments. See below. 

Orion NCM Server 
Hardware 

CPU Speed 3GHz dual core dual processor  

Memory 3GB 

Hard Drive Space 20GB 

Installing Windows 
Account 

Requires administrator permission on the target server  

File System Access 
Permissions 

Ensure the Network Service account has modify access to the system 

temp directory (%systemroot% \ temp ). 

SolarWinds Orion 
Syslog Server 

If you want realtime change detection triggered through devices 
sending Syslog messages, the executable must have read-write 
access to the Orion Core database. For more information, see 
“Enabling Realtime Configuration Change Detection” and “Monitoring 
SNMP”. 
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Software/Hardware Requirements 

SolarWinds Orion Trap 
Service 

If you want realtime change detection triggered through devices 
sending SNMP traps, the executable must have read-write access to 
the Orion Core database. For more information, see “Enabling 
Realtime Configuration Change Detection” and “Monitoring SNMP”. 

Microsoft SNMP Trap 
Service 

Must be installed if you want realtime change detection triggered 
through devices sending SNMP traps. For more information, see 
“Enabling Realtime Configuration Change Detection” and “Monitoring 
SNMP” in the Orion NCM Administrator Guide. 

Microsoft IIS Version 6 or later. DNS specifications require hostnames to be 
composed of alphanumeric characters (A-Z, 0-9), the minus sign (-),  
and periods (.). Underscore characters (_) are not allowed. For more 
information, see RFC 952. 
Note: SolarWinds neither recommends nor supports the installation of 
Orion NCM on the same server or using the same database server as 
a Research in Motion (RIM) Blackberry server. 

Microsoft ASP .NET 2.0 
Ajax Extension 

Version 1 or later (if this is not found on the target computer, the setup 
program downloads and installs the component) 

Microsoft .NET 
Framework 

Version 3.5 SP1 or later (if this is not found on the target computer, 
the setup program downloads and installs the component) 

Database 
The following database servers are supported as the Orion Network 
Configuration Manager datastore: 

¶ SQL Server 2008 Standard or Enterprise 

¶ SQL Server 2005 SP1 or later of Express, Standard, or Enterprise 
You can use the following database select statement to check your 
SQL Server version, service pack or release level, and edition: 

select SERVERPROPERTY ('productversion'), 

SERVERPROPERTY ('productlevel'), 

SERVERPROPERTY ('edition')  

 

Your database server must support mixed-mode authentication or 
SQL authentication and have the following protocols enabled: 

¶ Shared memory 

¶ TCP/IP 
Named Pipes 

SQL Server 2005 Express Edition does not enable these protocols. 
 
The following x86 components must be installed (if the components 
are not found on the target computer, the setup program downloads 
and installs the components): 

¶ SQL Server System Common Language Runtime (CLR) Types 

¶ Microsoft SQL Server Native Client 
Microsoft SQL Server Management Objects 

Enabling Full-Text Search on your Orion NCM database significantly 
increases search performance. 

Browser To access the Orion Network Configuration Manager website, use one 
of the following browsers: 

¶ Microsoft Internet Explorer 7 or later 

¶ Mozilla Firefox 3 or later 

¶ Google Chrome 8 
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Notes:  

¶ Typically, you can monitor between 8,000 and 10,000 devices with a single 
NCM instance; however, the total depends on your system hardware, the 
types of devices monitored, and the number and concurrency of the jobs you 
run.  Should you need to manage more devices, and you decide to add NCM 
instances, consider consolidating your views of multiple instances with the 
Orion Enterprise Operations Console. For more information about scaling 
NCM, please contact your account manager.  

¶  SolarWinds does not support installation of Orion NCM on Windows XP, 
Vista or Windows 7 in production environments. If you are installing Orion 
NCM on Windows Vista for evaluation purposes, ensure you enable the 
appropriate database protocols. See the database section of the 
requirements. 

¶ The Orion Network Configuration Manager Information Service requires the 

Net. Tcp Port Sharing Service  to be enabled and port 17777 open for 

TCP traffic to the Orion NCM computer. By default, this service is disabled. 
The setup program sets the service to manual. Resetting the service setting 
to disabled will adversely affect your installation. 

¶ To take advantage of the numerous integration points in Orion Network 
Configuration Manager, install the SolarWinds Engineer‟s Toolset on the 
same server. You can also take advantage of integration points built into the 
Web Console by installing the Toolset on computers used to access the Web 
Console. 

Server Sizing 

Orion Network Configuration Manager can perform configuration management 
for any sized network, from small corporate LANs to large enterprise and service 
provider networks. Most Orion NCM implementations perform well on 
Pentium-class 3GHz systems with 3GB of RAM using the default simultaneous 
transfer settings and no modification to node monitoring settings. 

Should scalability issues arise, consider adjusting the following variables: 

¶ Number of simultaneous transfers 

¶ Frequency of uploads, downloads, and inventory jobs 

¶ Node polling interval for up-down monitoring 

http://www.solarwinds.com/products/orion/eoc/
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In larger environments, inventory jobs may run longer than expected. To remedy 
this situation, consider breaking large inventory jobs into smaller jobs that do not 
include as many nodes and spacing these jobs over a larger period of time. 
Adjusting server CPU and memory will enhance user interface performance and 
job execution speed.  

Licensing Orion Network Configuration Manager 

Orion Network Configuration Manager can manage almost any network device, 
including routers, switches, and firewalls. Any of your version 3 or earlier SNMP 
enabled devices can provide configuration files to Orion Network Configuration 
Manager. You license Orion Network Configuration Manager by the number of 
nodes. A node is defined as an entire device, that is, a router, a switch, a server, 
an access point, or a modem. 

The following list provides the different types of Orion Network Configuration 
Manager licenses available: 

¶ Up to 50 devices (DL50) 

¶ Up to 100 devices (DL100) 

¶ Up to 200 devices (DL200) 

¶ Up to 500 devices (DL500) 

¶ Up to 1000 devices (DL1000) 

¶ Up to 3000 devices (DL3000) 

¶ Unlimited devices (DLX) 

Obtaining a Software License Key 

If you are prompted for your name, email address, phone number, customer ID, 
and password, complete the following procedure. 

Note: Versions of the NCM software that are released during the release 
candidate period have a limited license. In upgrading your NCM software, even if 
the software does not change from the release-to-manufacture (RTM) to the 
general availability (GA) distributions, you must re-apply your license upon the 
software‟s official release.  

To license your product: 

1. From the appropriate server in your deployement, navigate to 
http://www.solarwinds.com/customerportal and enter the requested 
information to obtain your Activation Key. 

http://www.solarwinds.com/customerportal


 

 
10 Ö Installing Orion Network Configuration Manager 

¶ If you are deploying Orion NCM on one server and integrating with 
Orion products on a different server, then you must install the Orion 
NCM license on the server running the other Orion product. 

For example, if you are integrating Orion NCM on one machien with 
Orion NPM on another, you would install your Orion NCM license on the 
machine that is hosting Orion NPM. 

¶ If you are deploying Orion NCM standalone or on a single integrated 
server, then you must install the Orion NCM license on that server. 

2. If you have both an activation key and access to the internet, select the 
first option, I have internet access and an activation keyé, enter your 
Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check I 
access the internet through a proxy server, and then provide the Proxy 
address and Port. 

3. If you do not have access to the internet from your designated Orion 
NCM server, select This server does not have internet accessé, click 
Next, and then complete the steps provided. 

About the Orion Network Configuration Manager 
Database 

A copy of Microsoft SQL Server 2005 Express Edition is distributed with each 
copy of Orion Network Configuration Manager. SQL Server 2005 Express Edition 
supports a maximum database size of 4GB, is limited to 1 GB of RAM use, and 
takes advantage of only 1 CPU in a multi-processor server. For more information 
about SQL Server installation, see the Microsoft website at 
http://www.microsoft.com/sql. 

If you are installing Orion NCM on the same server as Orion NPM, consider 
using a remote database server for your databases. You will gain a number of 
performance enhancements through implementing this installation scenario, as 
the Orion server will no longer need to share resources with SQL Server. 

Warnings:  

¶ The following characters cannot be included in the database name: 
asterisk (* ), closing square bracket (] ), colon (: ), semicolon (; ), single quote 

(' ), double quote (" ), backward slash (\ ), forward slash (/ ), less than (<), 

greater than (>), and question mark (?).  

¶ Do not include the single quote (' ) or the semicolon (; ) in the username or 

password of the database account.  

http://www.microsoft.com/sql
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SNMP Communication 

Orion Network Configuration Manager takes advantage of SNMP communication 
to collect inventory information. Ensure all devices from which you want to collect 
detailed information have SNMP properly configured. 

Planning the Orion NCM Deployment 

How you intend to use Orion NCM determines the process by which you install 
the software. There are three deployment types: Standalone, Integrated Single 
Server, and Integrated Separate Servers. 

Essentially, you need to decide if you intend to run Orion NCM by itself on a 
single server or integrated with other Orion products, either on a single server or 
on separate servers. 

Here is the current list and version of Orion products with which Orion NCM 
version 7.0 can integrate: 

¶ Orion Network Performance Manager (NPM) version 10.2 and above 

¶ Orion Application Manager (APM) version 3.5 and above. 

¶ Orion IP Address Manager (IPAM) version 1.7.1 and above. 

¶ SolarWinds User Device Tracker (UDT) version 1.0.1 and above 

Orion NCM Standalone 

This option installs NCM by itself on one server. If you select this option, you will 
be able to install other Orion products--on this server only--at a future time; but 
you will not be able to integrate NCM with remotely installed Orion products, 
either now or in the future. 

. 
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Orion NCM Integrated with another Orion Product 

Integrating Orion NCM with another Orion product add combines all the 
functionality of the products into the Orion NPM Web Console.  

For more information about the resources, click Help on the individual resource. 
Functionality remains the same, including the need to be in the appropriate Orion 
NCM roles. 

 Single Server Integration 

This option installs NCM on a single server on which already resides other 
compatible Orion Core products (Orion NPM, Orion APM, Orion IPAM, or 
SolarWinds UDT).  

 

Separate Server Integration 

This option installs NCM on two separate servers, a primary NCM server and 
another server on which already reside other compatible Orion Core products 
(Orion NPM, Orion APM, Orion IPAM, or SolarWinds UDT).  

To properly install NCM in this deployment, you must first install NCM on the 
server hosting the Orion Core product(s).  

 

When that server is properly setup, you should then install NCM version 7.0 on 
server where the primary NCM server will reside. 

Installing Orion Network Configuration Manager 
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Orion NCM version 7.0 is architected so that the software is integrated with a 
core platform of components that are common to all Orion products. Besides the 
Orion NCM database, the NCM software also creates an Orion Core database to 
manage account and other information that pertains to Orion common 
components.  

Nodes are considered an Orion common component in Orion NCM version 7.0. 
Every node managed in NCM must also be managed in the Orion Core 
database; and the Orion Core database is the key to maintaining continuity for a 
node through its states of management and unmanagement while you use the 
Orion NCM product. 

It is a feature of Orion NCM that if you delete a node from the Orion Core 
database all existing data for that node, including all backed-up configuraitons, 
are permanently removed. 

Because Orion NCM 7.0 shares common components with all Orion products, 
the process of installing and configuring Orion NCM involves shutting down and 
restarting all Orion services. Choose a time to install Orion NCM 7.0 when your 
IT operation can tolerate a short period of downtime for Orion products. 

Installing Orion Network Configuration Manager version 7.0 involves 5 
processes: 

 

¶ Installing the NCM software 

¶ Configuring NCM and the NCM database 

¶ Configuring Orion Core components and the Orion Core database 

¶ Discovering nodes to monitor in Orion and NCM 

¶ Synchronizing the NCM and Orion Core databases 
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Notice that installing the configuring Orion NCM involves running two sessions of 
the Orion Configuration Wizard; the first session to configure Orion NCM and the 
NCM database, the second to configure Orion Core components and the Orion 
Core database. 

You can find Orion NCM 7.0 installation software in your customer portal. 

Follow the steps in the installation section below that corresponds to your 
deployment type.  

Installing Orion NCM Standalone (Single Server) 

Follow these installation steps if you will run Orion NCM on a single server and 
currently have no intention to integrate with other Orion products. 

The following procedures take you through all five related processes—as one set 
of numbered steps—for installing Orion NCM by itself on a single server..  

You must complete all the steps for Orion NCM to be correctly installed. 

To install Orion Network Configuration Manager: 

1. Log on with a local administrator account to the computer on which you want 
to install Orion Network Configuration Manager. 

Note: To ensure that Orion Network Configuration Manager runs properly, do 
not install Orion Network Configuration Manager on a domain controller. 

2. Navigate to your download location and launch the executable. 

3. Click Next on Getting Ready to Install. 

4. Click Next after reviewing the Process Overivew. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database. 

5. Click Next after reviewing the deployment options.  

Since you are following this set of steps you already have chosen to install 
Orion NCM standalone on a single server. 

6. Click No, I want to install/upgrade NCM on one serveré and click Next. 

7. Review the Welcome text, click Next. 

8. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

9. Accept the default directory for the installation or Browse to another, then 
click Next. 

http://www.solarwinds.com/customerportal/
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10. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

11. Click Finish when the Setup Wizard completes its copying. 

12. If you are prompted to license Orion NCM, click Enter Licensing 
Infromation and then complete the following procedure to license your Orion 
NCM installation: 

a. If you have both an activation key and access to the internet, select 
the first option, I have internet access and an activation keyé, enter 
your Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check 
access your access toa the internet through a proxy server, and then 
provide the Proxy address and Port. 

b. If you do not have access to the internet from your designated 
Orion NCM server, select This server does not have internet 
accessé, click Next, and then complete the steps provided.. 

You need a customer ID and password to successfully install the key. 
For more information, see the section “Obtaining a Software License 
Key”. 

13. Enter registration information, including your name and a valid email 
address, and click Finish. 

If licensing failed for some reason the software should automatically mark the 
installation as an evaluation. You will have 30 days to enter valid license 
information. 

14. Click Next after reviewing your progress in the Process Overview. 

The first of the two configuration wizards launches The first wizard configures 
NCM and the NCM database; and the second configures Orion common 
components and the Orion Core database. 

15. Accept the defaults (Database and Services) and click Next. 

The Orion Network Configuration Manager Wizard starts running through the 
Orion NCM database setup. 

16. Specify the SQL Server instance you want to use for storing configurations 
and node details, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

17. If this is the first time you are installing Orion NCM, click Create a new 
database, and then click Next.  

Otherwise, select the existing Orion NCM database you want to use, and 
then click Next. 

18. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

19. If all three Service Settings are selected, click Next. 

20. Review the actions to be taken with the Database and Services, click Next. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

21. Click Finish when the wizard completes its configuration actions. 

22. Click OK to acknowledge that a second configuration wizard, the Orion Core 
Configuration Wizard, will start in a few moments.  

The Orion Core database stores all discovered nodes. This is a superset of 
nodes from which you will license specific nodes for NCM monitoring and 
configuration. 

23. Click Next after reviewing your progress in the Process Overview. 

The second configuration wizard launches The second wizard configures 
Orion common components and the Orion Core database. 

24. Review the Welcome text, click Next. 

25. To create the Orion Core database, you need to specify the appropriate SQL 
Server instance, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

26. Click Create a new database, provide a name, and then click Next. 

27. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

28. Click Next setup the Orion Website with default settings or adjust the 
seetings as needed. 

29. Click Yes if you are informed that a website already exists with the same 
settings. 

30. Click Next after reviewing the settings that will be configured. 

31. Click Next after reviewing the overview configuration plan for the Database, 
Website, and Services. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

32. Click Finish when the wizard completes. 

Orion Web Console launches.   

33. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

34. Click NETWORK SONAR DISCOVERY under NCM Nodes to discover the 
nodes for Orion NCM to manage. 

The software navigates to the Network Sonar Wizard. 

35. Review and accept the defaults (public/private) for the SNMP read-only and 
read-write community strings; or click the pencil icon to edit a credential. 
Click Next when you are finished.  

These default strings are tried first the software interactively requests a 
credential during node discovery. 

36. Click Add New Credential under Windows Credentials as needed. 

WMI is used to collect CPU, memory, volume and other data from Windows 
Servers that do not support SNMP.  

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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37. Define an IP range, subnet, or a list of specific nodes for the wizard to use in 
discovering nodes. Click Next when you are finished. 

38. Review and adjust discovery settings. Click Ignore nodesé if you want to 
ignore nodes that provide no SNMP or WMI information. 

Click Next when you are finished. 

39. Click DISCOVER to start discovering nodes. 

40. Click Next when you are ready import the devices types discovered.  

41. Click Next when you are ready import the volume types discovered. 

42. Click Import after you have reviewed and adjusted (as needed) the list of 
devices and volumes. 

Details and progress of the import operation is shown in real-time in the 
Import Results window. 

43. Click Finish when the import operation is done. 

The software navigates to Discovery Central.  

44. Review the NCM node count in Manage More Nodes under the NCM Nodes 
option group. 

The nodes managed in NCM are the results of the Network Sonar Wizard 
session just finished. In discovering these nodes, the software has 
automatically added the nodes to the Orion Core database. 

Orion NCM nodes must also be managed in the Orion Core database for the 
NCM software to function correctly. 

45. Click CONFIGS in the Orion NCM Web Console toolbar. 
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Installing Orion NCM on Integrated Single Server 

Follow these installation steps if you will run Orion NCM on a single server and 
intend to integrate it with an Orion product that already resides on the server. 

The following procedures take you through all five related processes—as one set 
of numbered steps—for installing Orion NCM and integrating with an Orion 
product on a single server..  

You must complete all the steps for Orion NCM to be correctly installed. 

To install Orion Network Configuration Manager: 

1. Log on with a local administrator account to the computer on which you want 
to install Orion Network Configuration Manager. 

Note: To ensure that Orion Network Configuration Manager runs properly, do 
not install Orion Network Configuration Manager on a domain controller. 

2. Navigate to your download location and launch the executable. 

3. Take a back-up of your existing Orion product database.  

For detailed information, see “Creating Database Backups” in your Orion 
product‟s Administrator Guide. 

4. Click Next on Getting Ready to Install. 

5. Click Next after reviewing the Process Overivew. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database which NCM and the other Orion products on the server 
share. 

6. Click Next after reviewing the deployment options.  

Since you are following this set of steps you already have chosen to install 
Orion NCM integrated with an Orion product on a single server. 

7. Click Yes, this server will be used to perform NCM Server Operations, 
and click Next. 

8. Review the Welcome text, click Next. 

9. Typing Yes acknowledges that you are aware of the need to back up your 
existing Orion product database. Click Next when you are ready. 

10. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 
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11. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

12. Click Finish when the Setup Wizard completes its copying. 

13. If you are prompted to license Orion NCM, click Enter Licensing 
Infromation and then complete the following procedure to license your Orion 
NCM installation: 

a. If you have both an activation key and access to the internet, select 
the first option, I have internet access and an activation keyé, enter 
your Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check 
access your access toa the internet through a proxy server, and then 
provide the Proxy address and Port. 

b. If you do not have access to the internet from your designated 
Orion NCM server, select This server does not have internet 
accessé, click Next, and then complete the steps provided.. 

You need a customer ID and password to successfully install the key. 
For more information, see the section “Obtaining a Software License 
Key”. 

14. Enter registration information, including your name and a valid email 
address, and click Finish. 

If licensing failed for some reason the software should automatically mark the 
installation as an evaluation. You will have 30 days to enter valid license 
information. 

15. Click Next after reviewing your progress in the Process Overview. 

The first of the two configuration wizards launches The first wizard configures 
NCM and the NCM database. 

16. Accept the defaults (Database and Services) and click Next. 

The Orion Network Configuration Manager Wizard starts running through the 
Orion NCM database setup. 

17. Specify the SQL Server instance you want to use for storing configurations 
and node details, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

18. If this is the first time you are installing Orion NCM, click Create a new 
database, and then click Next.  

Otherwise, select the existing Orion NCM database you want to use, and 
then click Next. 

19. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

20. If all three Service Settings are selected, click Next. 

21. Review the actions to be taken with the Database and Services, click Next. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

22. Click Finish when the wizard completes its configuration actions. 

23. Click OK to acknowledge that a second configuration wizard, the Orion Core 
Configuration Wizard, will start in a few moments.  

The Orion Core database stores all discovered nodes for your Orion 
products. This is a superset of nodes from which you will license specific 
nodes for NCM monitoring and configuration. 

24. Click Next after reviewing your progress in the Process Overview. 

The second configuration wizard launches The second wizard configures 
Orion common components and the Orion Core database. 

25. Review the Welcome text, click Next. 

26. Specify the appropriate SQL Server instance, the authentication method 
(Windows or SQL Server Authentication) used to communicate with the 
instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

27. Provide the database name for your current Orion product—the one with 
which you want NCM to integrate—and then click Next.  

28. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

29. Click Next setup the Orion Website with default settings or adjust the 
seetings as needed. 

30. Click Yes if you are informed that a website already exists with the same 
settings. 

31. Click Next after reviewing the settings that will be configured. 

32. Click Next after reviewing the overview configuration plan for the Database, 
Website, and Services. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

33. Click Finish when the wizard completes. 

Orion Web Console launches.   

34. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

Since this is the your first time logging, the software navigates to Discovery 
Central and highlights Manage More Nodes under NCM Nodes. You may 
need to scroll down to see this part of Discovery Central. 

The current number of Orion Core nodes that NCM is managing is reported; 
most likely the number is 0. 

35. Click Manage More Nodes under NCM Nodes. 

36. Use the Licensed by NCM column to review the NCM license status of Orion 
Core nodes. 

 [No Grouping] lets you see all devices in the list, which is useful for quickly 
reviewing overall NCM license status (Licensed by NCM column).  

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Otherwise, select a Group by setting to organize the list as needed.  

37. Click the relevant nodes and then click Add Nodes to NCM. 

For these nodes you will see the status in Licensed by NCM change to Yes. 

38. Click NETWORK SONAR DISCOVERY under NCM Nodes to discover the 
nodes for Orion NCM to manage. 

39. Click Yes when prompted to edit properties for the nodes you have added to 
NCM. 

40. Click on a property group (for example Polling Method) and edit the setting 
as needed. 

Keep in mind that the settings you select are applied to all selected nodes. 

41. Click Submit when you have finished editing. 

NCM nodes must also be managed in the Orion Core database. In case 
there is any disparity between the databases, we run a node synchronization 
next. 

42. Click Node Sync. 

43. Click SYNC NODES under Node Synchronization. 

The software reports the action taken. 

44. Click Finish. 

45. Click CONFIGS in the Orion NCM Web Console toolbar. 

Installing Orion NCM on Integrated Separate Servers 

Follow these installation steps if you will run Orion NCM on a separate server 
from the Orion product with which you intend to integrate. 

The following procedures take you through all five related processes—as one set 
of numbered steps—for installing Orion NCM and integrating it with an Orion 
product on a different server.  

You must complete all the steps for Orion NCM to be correctly installed. 

To install Orion Network Configuration Manager: 

1. Log on with a local administrator account to the computer where your Orion 
product—the one with which you intend to integrate NCM—is currently 
installed. 

This server is sometimes referred to as the Orion Core server since it 
contains the common components shared by Orion products. 

The following steps are all to be completed on the computer that will 
host your Orion Core server. 
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2. Navigate to your download location on the Orion Core server and launch the 
Orion NCM executable on the Orion . 

3. Take a back-up of your existing Orion product database.  

For detailed information, see “Creating Database Backups” in your Orion 
product‟s Administrator Guide. 

4. Click Next on Getting Ready to Install. 

5. Click Next after reviewing the Process Overivew. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database which NCM and the other Orion products on the server 
share. 

6. Click Next after reviewing the deployment options.  

Since you are following this set of steps you already have chosen to install 
Orion NCM integrated with an Orion product on a separate server. 

7. Click No, my primary NCM is on a different server, and click Next. 

8. Review the Welcome text, click Next. 

9. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

10. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

11. Click Finish when the Setup Wizard completes its copying. 

12. Click Next after reviewing your progress in the Process Overview. 

The SolarWinds Core configuration wizard launches to configure Orion 
common components and the Orion Core database. 

13. Review the Welcome text, click Next. 

14. Specify the SQL Server instance—where the Orion Core database is 
located—and enter the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance. Click Next when you 
are ready. 

The SQL Server instance must support SQL authentication or mixed mode. 
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

15. Click Use an existing database, select the Orion Core database in the 
dropdown list, and then click Next.  

Otherwise, select the existing Orion NCM database you want to use, and 
then click Next. 

16. Click Use and existing account and select the account credentials from the 
dropdown list. Click Next when you are ready. 

17. Accept the default for Website Settings and click Next. 

18. Click Yes to acknowledge that the website already exists and that you want 
to proceed. 

19. Click Next after reviewing the services to install. 

20. Click Next after reviewing the Database, Website, and Services to be 
configured. 

The green progress bars and descriptive text explain what is being done and 
how far along it is. 

21. Click Finish to complete installation and configuration. 

You are done with the first part of the installation. 

Take a breath. 

The following steps are all to be completed on the computer that will 
host your main Orion NCM Server. 

22. Log on with a local administrator account to the computer that will host your 
main Orion NCM Server. 

23. Navigate to your download location and launch the Orion NCM executable. 

24. Click Next on Getting Ready to Install. 

25. Click Next after reviewing the Process Overivew. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database which NCM and the other Orion products on the server 
share. 

26. Click Next after reviewing the deployment options.  
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Since you are following this set of steps you already have chosen to install 
Orion NCM integrated with an Orion product on a separate server. 

27. Click Yes, I want to install/upgrade NCM and integrate with currently 
installed Orion products on a different server, and click Next. 

28. Enter the information for the server where the Orion product—with which you 
want to integrate—is currently installed. 

For the SolarWinds Orion User Password enter the credentials that you use 
to access the Orion Web Console. 

Note: If you receive an error, there are three possible causes: the login 
credentials provided are incorrect, the target server—where the Orion 
product currently resides—does not yet have the NCM integration 
components installed on it, or the network has a problem that is obstructing 
connectivity. 

29. Review the Welcome text, click Next. 

30. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

31. Accept the default installation path or use Browse to modify it. Click Next 
when you are finished. 

32. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

33. Click Finish when the Setup Wizard completes its copying. 

34. Click Next after reviewing your progress in the Process Overview. 

The first of the two configuration wizards launches The first wizard configures 
NCM and the NCM database. 

35. Accept the defaults (Database and Services) and click Next. 

The Orion Network Configuration Manager Wizard starts running through the 
Orion NCM database setup. 

36. Specify the SQL Server instance you want to use for storing configurations 
and node details, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

37. If this is the first time you are installing Orion NCM, click Create a new 
database, provide the appropriate database server and a name for the new 
database, and then click Next.  

Otherwise, select the existing Orion NCM database you want to use, and 
then click Next. 

38. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

39. If all three Service Settings are selected, click Next. 

40. Review the actions to be taken with the Database and Services, click Next. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

41. Click Finish when the wizard completes its configuration actions. 

42. Click OK to acknowledge that a second configuration wizard, the Orion Core 
Configuration Wizard, will start in a few moments.  

The Orion Core database stores all discovered nodes for your Orion 
products. This is a superset of nodes from which you will license specific 
nodes for NCM monitoring and configuration. 

43. Click Next after reviewing your progress in the Process Overview. 

The second configuration wizard launches The second wizard configures 
Orion common components and the Orion Core database. 

44. Review the Welcome text, click Next. 

45. Specify the appropriate SQL Server instance, the authentication method 
(Windows or SQL Server Authentication) used to communicate with the 
instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

46. Provide the database name for your current Orion product—the one with 
which you want NCM to integrate—and then click Next.  

47. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

48. Click Next after you are finished reviewing the Services to install. 

49. Click Next after reviewing the Database and Services that will be configured. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

50. Click Finish when the wizard completes. 

Orion Web Console launches.   

51. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

Since this is the your first time logging, the software navigates to Discovery 
Central and highlights Manage More Nodes under NCM Nodes. You may 
need to scroll down to see this part of Discovery Central. 

The current number of Orion Core nodes that NCM is managing is reported; 
most likely the number is 0. 

52. Click Manage More Nodes under NCM Nodes. 

53. Use the Licensed by NCM column to review the NCM license status of Orion 
Core nodes. 

 [No Grouping] lets you see all devices in the list, which is useful for quickly 
reviewing overall NCM license status (Licensed by NCM column).  

Otherwise, select a Group by setting to organize the list as needed.  

54. Click the relevant nodes and then click Add Nodes to NCM. 

For these nodes you will see the status in Licensed by NCM change to Yes. 

55. Click Yes when prompted to edit properties for the nodes you have added to 
NCM. 

56. Click on a property group (for example Polling Method) and edit the setting 
as needed. 
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Keep in mind that the settings you select are applied to all selected nodes. 

57. Click Submit when you have finished editing. 

NCM nodes must also be managed in the Orion Core database. In case 
there is any disparity between the databases, we run a node synchronization 
next. 

58. Click Node Sync. 

59. Click SYNC NODES under Node Synchronization. 

The software reports the action taken. 

60. Click Finish. 

61. Click CONFIGS in the Orion NCM Web Console toolbar. 
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Upgrading Orion Network Configuration Manager 

 

Orion NCM version 7.0 is architected so that the software is integrated with a 
core platform of components that are common to all Orion products. Besides the 
Orion NCM database, the NCM software also creates an Orion Core database to 
manage account and other information that pertains to Orion common 
components. 

If you are currently running Orion NCM on a server with other Orion products, but 
Orion NCM is not currently integrated with those products (for example, Orion 
Network Performance Monitor), upgrading to Orion NCM version 7.0 on your 
current NCM server will automatically integrate Orion NCM with the other Orion 
products. If you do not want to integrate Orion NCM with other Orion products, 
install Orion NCM version 7.0 on its own server. To do that, consult the section 
“Moving Orion NCM from a Non-Integrated Single to a New NCM Server”. 

Nodes are considered an Orion common component in Orion NCM version 7.0. 
Every node managed in NCM must also be managed in the Orion Core 
database; and the Orion Core database is the key to maintaining continuity for a 
node through its states of management and unmanagement while you use the 
Orion NCM product. 

It is a feature of Orion NCM that if you delete a node from the Orion Core 
database all existing data for that node, including all backed-up configuraitons, 
are permanently removed. 

If you are an existing customer, and your current version does not qualify for a 
direct upgrade to Orion NCM version 7.0, you first need to install the versions of 
Orion NCM that at least bring your installation to Orion NCM version 6.0. 

For example, if you are running Orion NCM version 5.5, you need to install Orion 
NCM versions 5.5.1, 5.5.2, and 6.0 before you can install Orion NCM 7.0. 
Additionally, in this case, should you want to gain access to the latest NCM/NPM 
integration features, you would need to upgrade your SolarWinds Network 
Performance Manager software to version 10.2 or higher. 

If you need previous versions of Orion NCM, Contact Customer Service and 
Support (customerservice@solarwinds.com).  

Note: Windows XP, Windows Vista, and Windows 7 are supported only for 
evaluation purposes. If you are installing on Windows XP, Windows Vista, or 
Windows 7 and want to use the Orion NCM Web Console, ensure you have 
installed Microsoft Internet Information Server 6 or later. The setup program 
stops the default website and starts the Orion NCM Web Console. Only one 
website can be active on IIS when installed on Windows XP, Windows Vista, or 
Windows 7. 

mailto:customerservice@solarwinds.com
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NCM deployments integrated with multiple NPM instances 

Due to the new Orion NCM architecture, any existing Orion NCM integration with 
multiple instances of Orion NPM are not sustainable in their current form. Since 
there is no NCM Integration Module with Orion NCM version 7.0, you cannot use 
a single instance of NCM to manage nodes on different NPM instances. If you 
are running a current deployment of this kind, to replicate it with Orion NCM 
version 7.0, you must license Orion NCM for each of the NPM instances for 
which you want NCM integration. Depending on your objectives, this may require 
a different licensing strategy; you may need to license Orion NCM in multiple 
smaller bundles than in the a single larger one. 

Moving Orion NCM from a Non-Integrated Single to a New NCM Server 

If you are currently running Orion NCM on the same server with Orion Network 
Performance Monitor, but the two products are not integrated, and you prefer to 
keep them unintegrated, follow the steps in this section. 

1. Back-up existing NCM jobs by copying them to a temporary directory from 
(by default): C:\Program Files (x86)\Solarwinds\Network Configuration 
Manager\Jobs.  

2. Uninstall the Orion NCM from the current Orion NCM server. 

3. Follow the steps under “Installing Orion NCM Standalone (Single Server)”. 

4. When you are finished installing Orion NCM versions 7.0, copy your backed-
up Orion NCM jobs from the previous Orion NCM server to (by default): 
C:\Program Files\Solarwinds\Orion\NCM\Jobs. 

5. Edit each job, retyping the appropriate password when prompted. 

Moving Orion NCM from Integrated Single to Integrated Separate Servers 

If you are currently running Orion NCM in integration with Orion Network 
Performance Monitor on a single server, and you would prefer to use this 
upgrade as an opportunity to split the Orion NCM and other Orion products onto 
different servers, while still maintaining integration, follow the steps in this 
section. 

To move Orion NCM from integrated single to integrated separate servers: 

1. Back-up existing NCM jobs by copying them to a temporary directory from 
(by default): C:\Program Files (x86)\Solarwinds\Network Configuration 
Manager\Jobs.  

2. Uninstall the Orion NCM and the Orion NCM integration module from the 
current Orion NCM server. 

3. Follow the steps under “Installing Orion NCM on Integrated Separate 
Servers”. 
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4. When you are finished installing Orion NCM versions 7.0, copy your backed-
up Orion NCM jobs from the previous Orion NCM server to (by default): 
C:\Program Files\Solarwinds\Orion\NCM\Jobs. 

5. Edit each job, retyping the appropriate password when prompted. 

Upgrading Orion NCM Standalone (Single Server) 

Follow these steps if you will run Orion NCM on a single server and intend not to 
integrate it with an Orion product that already resides on the server. 

These procedures take you through all five related processes—as one set of 
numbered steps—for upgrading Orion NCM on a single server. 

You must complete all the steps for Orion NCM to be correctly upgraded. 

To upgrade Orion Network Configuration Manager: 

1. Log on with a local administrator account to the computer on which you want 
to install Orion Network Configuration Manager. 

Note: To ensure that Orion Network Configuration Manager runs properly, do 
not install Orion Network Configuration Manager on a domain controller. 

2. Navigate to your download location and launch the executable. 

3. Click Next on Getting Ready to Install. 

4. Click Next after reviewing the Process Overivew. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database. 

5. Click Next after reviewing the deployment options.  

6. Stop. Read the information about the dual database architecture inherent in 
Orion NCM 7.0. (Click Next to acknowledge that you understand the dual 
database architecture concept.) 

7. If you do not want to integrate Orion NCM with other Orion products on your 
existing NCM server, click Cancel and consult the section “Moving Orion 
NCM from a Non-Integrated Single to a New NCM Server”.  

Click Next only if you are ready to proceed with the upgrade and expect to 
end up with an Orion NCM deployment on a single server that is integrated 
with Orion Network Performance Monitor or the other compatible Orion 
products that are currently installed on the NCM server. 
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8. Review the Welcome text, click Next. 

9. Type Yes after creating your database back-up, and then click Next. 

10. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

11. If prompted, accept the default directory for the installation or Browse to 
another, then click Next. 

12. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

13. Click Finish when the Setup Wizard completes its copying. 

14. If you are prompted to license Orion NCM, click Enter Licensing 
Infromation and then complete the following procedure to license your Orion 
NCM installation: 

a. If you have both an activation key and access to the internet, select 
the first option, I have internet access and an activation keyé, enter 
your Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check 
access your access toa the internet through a proxy server, and then 
provide the Proxy address and Port. 

b. If you do not have access to the internet from your designated 
Orion NCM server, select This server does not have internet 
accessé, click Next, and then complete the steps provided.. 

You need a customer ID and password to successfully install the key. 
For more information, see the section “Obtaining a Software License 
Key”. 

15. Enter registration information, including your name and a valid email 
address, and click Finish. 

If licensing failed for some reason the software should automatically mark the 
installation as an evaluation. You will have 30 days to enter valid license 
information. 

16. Click Next after reviewing your progress in the Process Overview. 

The first of the two configuration wizards launches The first wizard configures 
NCM and the NCM database; and the second configures Orion common 
components and the Orion Core database. 

17. Accept the defaults (Database and Services) and click Next. 

The Orion Network Configuration Manager Wizard starts running through the 
Orion NCM database setup. 
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18. Specify the SQL Server instance you want to use for storing configurations 
and node details, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

19. If you want to create a new database, click Create a new database, and 
then click Next.  

Otherwise, select the existing Orion NCM database you want to use, and 
then click Next. 

20. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

21. If all three Service Settings are selected, click Next. 

22. Review the actions to be taken with the Database and Services, click Next. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

23. Click Finish when the wizard completes its configuration actions. 

24. Click OK to acknowledge that a second configuration wizard, the Orion Core 
Configuration Wizard, will start in a few moments.  

The Orion Core database stores all discovered nodes. This is a superset of 
nodes from which you will license specific nodes for NCM monitoring and 
configuration. 

25. Click Next after reviewing your progress in the Process Overview. 

The second configuration wizard launches The second wizard configures 
Orion common components and the Orion Core database. 

26. Review the Welcome text, click Next. 

27. To create the Orion Core database, you need to specify the appropriate SQL 
Server instance, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

¶ If you are running Orion NCM on the same server as another compatible 
Orion product, the software has automatically detected the database 
relevant to that Orion product and will be using it as the Orion Core 
database; in this case, you will not be prompted to create a database 
and database server user account as indicated in the next few steps (27-
32). Instead, the NCM software will install the Orion Web component that 
is required for Orion NCM integration with the other Orion product.  

28. Click Create a new database, provide a name, and then click Next. 

29. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

30. Click Next setup the Orion Website with default settings or adjust the 
seetings as needed. 

31. Click Yes if you are informed that a website already exists with the same 
settings. 

32. Click Next after reviewing the settings that will be configured. 

33. Click Next after reviewing the overview configuration plan for the Database, 
Website, and Services. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.  

34. Click Finish when the wizard completes. 

Orion Web Console launches.   

35. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

36. Click Finish when the wizard completes. 

Orion Web Console launches.   

37. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Since this is the your first time logging-in after upgrade, the software 
navigates to a page called Node Synchronization and highlights Sync 
Nodes. 

38. Click Sync Nodes. 

All NCM nodes must also be managed in the Orion Core database for you to 
perform NCM work on a node. 

39.  Click Synchronize Databases under Node Synchronization. You may need 
to scroll down to see this part of Discovery Central. 

This operation reports its results in the form of: 

 (n) existing nod(s) synchronized. 

(n) new node(s) added to Orion Core. 

40. Click Finish. 

41. Click CONFIGS in the Orion NCM Web Console toolbar. 

Upgrading Orion NCM on Integrated Single Server 

Follow these steps if you will run Orion NCM on a single server and intend to 
integrate it with an Orion product that already resides on the server. 

If your existing version of your Orion product is not already upgraded to a version 
compatible with NCM 7.0, you must upgrade the Orion product first. Locate the 
relevant executable for the Orion product in your customer portal.  

The following procedures assume that your other Orion product has been 
upgraded to a version compatible with Orion NCM version 7.0; see the NCM 
version requirements of Orion products.  

These procedures take you through all five related processes—as one set of 
numbered steps—for upgrading Orion NCM and integrating with an Orion 
product on a single server. 

You must complete all the steps for Orion NCM to be correctly upgraded. 

To upgrade Orion Network Configuration Manager: 

1. Log on with a local administrator account to the computer on which you want 
to install Orion Network Configuration Manager. 

Note: To ensure that Orion Network Configuration Manager runs properly, do 
not install Orion Network Configuration Manager on a domain controller. 

2. Navigate to your download location and launch the executable. 

3. Take a back-up of your existing Orion product database.  

http://www.solarwinds.com/customerportal/
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For detailed information, see “Creating Database Backups” in your Orion 
product‟s Administrator Guide. 

4. Click Next on Getting Ready to Install. 

5. Click Next after reviewing the Process Overivew. 

Notice that after upgrading the NCM software the Installer runs two 
successive configuration wizards. The first wizard configures NCM and the 
NCM database; and the second configures Orion common components and 
the Orion Core database which NCM and the other Orion products on the 
server share. 

6. Click Next after reviewing the deployment options.  

Since you are following this set of steps you already have chosen to install 
Orion NCM integrated with an Orion product on a single server. 

7. Click Next to the installer software to upgrade the NCM software that it has 
detected on this server. 

If you receive and error regarding an unsupported version of installed Orion 
product—for example, Orion NCM version 10.1—you must discontinue this 
installation and upgrade the Orion product before attempting again to 
upgrade Orion NCM. 

8. Review the Welcome text, click Next. 

9. Typing Yes acknowledges that you are aware of the need to back up your 
existing Orion product database. Click Next when you are ready. 

10. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

11. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

12. Click Finish when the Setup Wizard completes its copying. 

13. If you are prompted to license Orion NCM, click Enter Licensing 
Infromation and then complete the following procedure to license your Orion 
NCM installation: 

a. If you have both an activation key and access to the internet, select 
the first option, I have internet access and an activation keyé, enter 
your Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check 
access your access toa the internet through a proxy server, and then 
provide the Proxy address and Port. 
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b. If you do not have access to the internet from your designated 
Orion NCM server, select This server does not have internet 
accessé, click Next, and then complete the steps provided.. 

You need a customer ID and password to successfully install the key. 
For more information, see the section “Obtaining a Software License 
Key”. 

14. Enter registration information, including your name and a valid email 
address, and click Finish. 

If licensing failed for some reason the software should automatically mark the 
installation as an evaluation. You will have 30 days to enter valid license 
information. 

15. Click Next after reviewing your progress in the Process Overview. 

The first of the two configuration wizards launches The first wizard configures 
NCM and the NCM database. 

16. Accept the defaults (Database and Services) and click Next. 

The Orion Network Configuration Manager Wizard starts running through the 
Orion NCM database setup. 

17. Specify the SQL Server instance you want to use for storing configurations 
and node details, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

18. Click Create a new database or select the existing Orion NCM database you 
want to use. Click Next when you are finished. 

19. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

20. If all three Service Settings are selected, click Next. 

21. Review the actions to be taken with the Database and Services, click Next. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

22. Click Finish when the wizard completes its configuration actions. 

23. Click OK to acknowledge that a second configuration wizard, the Orion Core 
Configuration Wizard, will start in a few moments.  

The Orion Core database stores all discovered nodes for your Orion 
products. This is a superset of nodes from which you will license specific 
nodes for NCM monitoring and configuration. 

24. Click Next after reviewing your progress in the Process Overview. 

The second configuration wizard launches The second wizard configures 
Orion common components and the Orion Core database. 

25. Click Yes to restart your system now and allow the NCM configuration 
changes take effect. Click No if you want to postpone rebooting this machine. 

26. Review the Welcome text, click Next. 

27. Specify the appropriate SQL Server instance, the authentication method 
(Windows or SQL Server Authentication) used to communicate with the 
instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

Notes: 

¶ If you are using a local instance of SQL Server Express, use the 
following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

28. Provide the database name for your current Orion product—the one with 
which you want NCM to integrate—and then click Next.  

29. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

30. Click Next setup the Orion Website with default settings or adjust the 
seetings as needed. 

31. Click Yes if you are informed that a website already exists with the same 
settings. 

32. Click Next after reviewing the settings that will be configured. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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33. Click Next after reviewing the overview configuration plan for the Database, 
Website, and Services. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

34. Click Finish when the wizard completes. 

Orion Web Console launches.   

35. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

Since this is the your first time logging after upgrade, the software navigates 
to a page called Node Synchronization and highlights Sync Nodes. 

36. Click Sync Nodes. 

All NCM nodes must also be managed in the Orion Core database for you to 
perform NCM work on a node. 

37.  Click Synchronize Databses under Node Synchronization. You may need to 
scroll down to see this part of Discovery Central. 

This operation reports its results in the form of: 

 (n) existing nod(s) synchronized. 

(n) new node(s) added to Orion Core. 

38. Click Finish. 

39. Click CONFIGS in the Orion NCM Web Console toolbar. 

Upgrading Orion NCM on Integrated Separate Servers 

Follow these steps if you will run Orion NCM on a separate server from the Orion 
product with which you intend to integrate. 

The following procedures take you through all five related processes—as one set 
of numbered steps—for upgrading Orion NCM and integrating it with an Orion 
product on a different server.  

You must complete all the steps for Orion NCM to be correctly upgraded. 

To upgrade Orion Network Configuration Manager: 

1. Log on with a local administrator account to the computer where your Orion 
product—the one with which you intend to integrate NCM—is currently 
installed. 

This server is sometimes referred to as the Orion Core server since it 
contains the common components shared by Orion products. 
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The following steps are all to be completed on the computer that will 
host your Orion Core server. 

2. Navigate to your download location on the Orion Core server and launch the 
Orion NCM version 7 executable on the Orion . 

3. Take a back-up of your existing Orion product database.  

For detailed information, see “Creating Database Backups” in your Orion 
product‟s Administrator Guide. 

4. Click Next on Getting Ready to Install. 

5. Click Next after reviewing the Process Overivew. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database which NCM and the other Orion products on the server 
share. 

6. Click Next after reviewing the deployment options.  

Since you are following this set of steps you already have chosen to install 
Orion NCM integrated with an Orion product on a separate server. 

7. Click No, my primary NCM is on a different server, and click Next. 

8. Review the Welcome text, click Next. 

9. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

10. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

11. Click Finish when the Setup Wizard completes its copying. 

12. Click Next after reviewing your progress in the Process Overview. 

The SolarWinds Core configuration wizard launches to configure Orion 
common components and the Orion Core database. 

13. Review the Welcome text, click Next. 

14. Specify the SQL Server instance—where the Orion Core database is 
located—and enter the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance. Click Next when you 
are ready. 

The SQL Server instance must support SQL authentication or mixed mode. 
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

15. Click Use an existing database, select the Orion Core database in the 
dropdown list, and then click Next.  

16. Click Use and existing account and select the account credentials from the 
dropdown list. Click Next when you are ready. 

17. Accept the default for Website Settings and click Next. 

18. Click Yes to acknowledge that the website already exists and that you want 
to proceed. 

19. Click Next after reviewing the services to install. 

20. Click Next after reviewing the Database, Website, and Services to be 
configured. 

The green progress bars and descriptive text explain what is being done and 
how far along it is. 

21. Click Finish to complete the upgrade and and start configuration. 

You are done with the first part of the ugrade. 

Take a breath. 

The following steps are all to be completed on the computer that will 
host your main Orion NCM Server. 

22. Log on with a local administrator account to the computer that will host your 
main Orion NCM Server. 

23. Navigate to your download location and launch the Orion NCM executable. 

24. Click Next on Getting Ready to Install. 

25. Click Next after reviewing the Process Overview. 

Notice that after installing the NCM software the Installer runs two successive 
configuration wizards. The first wizard configures NCM and the NCM 
database; and the second configures Orion common components and the 
Orion Core database which NCM and the other Orion products on the server 
share. 

26. Click Next after reviewing the deployment options.  

Since you are following this set of steps you already have chosen to install 
Orion NCM integrated with an Orion product on a separate server. 
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27. Click Yes, I want to install/upgrade NCM and integrate with currently 
installed Orion products on a different server, and click Next. 

28. Enter the information for the server where the Orion product—with which you 
want to integrate—is currently installed. 

For the SolarWinds Orion User Password enter the credentials that you use 
to access the Orion Web Console. 

Note: If you receive an error, there are three possible causes: the login 
credentials provided are incorrect, the target server—where the Orion 
product currently resides—does not yet have the NCM integration 
components installed on it, or the network has a problem that is obstructing 
connectivity. 

29. Review the Welcome text, click Next. 

30. Accept the license agreement displayed on the License Agreement window, 
and then click Next. 

31. Accept the default installation path or use Browse to modify it. Click Next 
when you are finished. 

32. Click Next to have the Setup Wizard start copying files. 

You should see the blue progress bar advancing with annotations of which 
files are being copied. 

33. Click Finish when the Setup Wizard completes its copying. 

34. Click Next after reviewing your progress in the Process Overview. 

The first of the two configuration wizards launches The first wizard configures 
NCM and the NCM database. 

35. Accept the defaults (Database and Services) and click Next. 

The Orion Network Configuration Manager Wizard starts running through the 
Orion NCM database setup. 

36. Specify the SQL Server instance you want to use for storing configurations 
and node details, the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

37. If this is the first time you are installing Orion NCM, click Create a new 
database, and then click Next.  

Otherwise, select the existing Orion NCM database you want to use, and 
then click Next. 

38. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

39. If all three Service Settings are selected, click Next. 

40. Review the actions to be taken with the Database and Services, click Next. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

41. Click Finish when the wizard completes its configuration actions. 

42. Click OK to acknowledge that a second configuration wizard, the Orion Core 
Configuration Wizard, will start in a few moments.  

The Orion Core database stores all discovered nodes for your Orion 
products. This is a superset of nodes from which you will license specific 
nodes for NCM monitoring and configuration. 

43. Click Next after reviewing your progress in the Process Overview. 

The second configuration wizard launches The second wizard configures 
Orion common components and the Orion Core database. 

44. Review the Welcome text, click Next. 

45. Specify the appropriate SQL Server instance, the authentication method 
(Windows or SQL Server Authentication) used to communicate with the 
instance, and then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

http://msdn.microsoft.com/en-us/library/ms143705.aspx
http://msdn.microsoft.com/en-us/library/ms143705.aspx
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Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

46. Provide the database name for your current Orion product—the one with 
which you want NCM to integrate—and then click Next.  

47. Create a new database account and password, or select an existing account 
with owner rights on the database you created or selected. Then click Next. 

48. Click Next after you are finished reviewing the Services to install. 

49. Click Next after reviewing the Database and Services that will be configured. 

The dual blue bars show progress and annotations of the wizard‟s current 
actions.   

50. Click Finish when the wizard completes. 

Orion Web Console launches.   

51. Enter an appropriate username and password. 

The default credentials are „adminô with no password. 

Since this is the your first time logging, the software navigates to Discovery 
Central and highlights Manage More Nodes under NCM Nodes. You may 
need to scroll down to see this part of Discovery Central. 

The current number of Orion Core nodes that NCM is managing is reported; 
most likely the number is 0. 

52. Click Manage More Nodes under NCM Nodes. 

53. Use the Licensed by NCM column to review the NCM license status of Orion 
Core nodes. 

 [No Grouping] lets you see all devices in the list, which is useful for quickly 
reviewing overall NCM license status (Licensed by NCM column).  

Otherwise, select a Group by setting to organize the list as needed.  

54. Click the relevant nodes and then click Add Nodes to NCM. 

For these nodes you will see the status in Licensed by NCM change to Yes. 

55. Click Yes when prompted to edit properties for the nodes you have added to 
NCM. 

56. Click on a property group (for example Polling Method) and edit the setting 
as needed. 
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Keep in mind that the settings you select are applied to all selected nodes. 

57. Click Submit when you have finished editing. 

Since this is the your first time logging after upgrade, the software navigates 
to a page called Node Synchronization and highlights Sync Nodes. 

58. Click Sync Nodes. 

All NCM nodes must also be managed in the Orion Core database for you to 
perform NCM work on a node. 

59.  Click Synchronize Databses under Node Synchronization. You may need 
to scroll down to see this part of Discovery Central. 

This operation reports its results in the form of: 

 (n) existing nod(s) synchronized. 

(n) new node(s) added to Orion Core. 

60. Click Finish. 

61. Click CONFIGS in the Orion NCM Web Console toolbar. 

Additional Polling Engine and Web Console  

According to your needs in managing the devices in your network you can add 
an additional poller or website to your Orion NCM deployment. An additional 
website adds versatility in accessing Orion NCM information and an additional 
poller adds scalability to the regular back-up of device configs. 

Installing an Additional Poller 

If you are upgrading to Orion NCM 7.0, before you attempt to install an additional 
poller on another server, you must first upgrade the main Orion NCM server. 

To upgrade the Orion NCM server follow the steps in “Chapter 2 
Installing Orion Network Configuration Manager”. 

Follow the steps in this section to install or upgrade an additional Orion NCM 
poller. 

1. Launch the executable (SolarWinds-Orion_AdditionalPoller.exe) from the 
location where you downloaded it on the server that will host your additional 
poller.  

Visit the Customer Portal to obtain the file if you do not already have it. 

2. Click Next on the Welcome screen. 

3. Click to accept the end user agreement, then click Next. 

http://www.solarwinds.com/customerportal/
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4. Click Next to accept the default installation directory or use Browse to adjust 
it. 

5. Click Next to start copying files. 

The software copies the files, including the Orion Core components needed 
for your server to communicate with the main poller. 

6. Click Finish when the files are finished being copied. 

7. If you are prompted to license the additional poller, click Enter 
Licensing Infromation and then complete the following procedure to license 
your installation: 

a. If you have both an activation key and access to the internet, select 
the first option, I have internet access and an activation keyé, enter 
your Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check 
access your access toa the internet through a proxy server, and then 
provide the Proxy address and Port. 

b. If you do not have access to the internet from your designated 
Orion NCM additional poller host server, select This server does not 
have internet accessé, click Next, and then complete the steps 
provided.. 

You need a customer ID and password to successfully install the key. 
For more information, see the section “Obtaining a Software License 
Key”. 

8. Review the Welcome text, click Next. 

9. Specify the SQL Server instance—where the Orion Core database is 
located—and enter the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance. Click Next when you 
are ready. 

The SQL Server instance must support SQL authentication or mixed mode. 

Notes: 

¶ If you are using a local instance of SQL Server Express, use the 

following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

10. Click Use an existing database, select the Orion Core database in the 
dropdown list, and then click Next.  
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11. Click Use and existing account and select the account credentials from the 
dropdown list. Click Next when you are ready. 

12. Click Next after reviewing the services to install. 

13. Click Yes to acknowledge that the SNMP Trap Serivce will be disable while 
the SolarWinds Trap Serivce is installed. 

14. Click Next after reviewing the Database and Services to be configured. 

The green progress bars and descriptive text explain what is being done and 
how far along it is. 

15. Click Launch Orion Web and Finish to complete configuration and bring up 
the website on your additional poller. 

Installing an Additional Website 

If you are upgrading to Orion NCM 7.0, before you attempt to install an additional 
website on another server, you must first upgrade the main Orion NCM server. 

To upgrade the Orion NCM server follow the steps in “Chapter 2 
Installing Orion Network Configuration Manager”. 

Follow the steps in this section to install or upgrade your additional website. 

1. Launch the executable (SolarWinds-Orion_WebOnly.exe) from the location 
where you downloaded it on the server that will host your additional poller.  

Visit the Customer Portal to obtain the file if you do not already have it. 

2. Enter the hostname or IP address and the Orion administrator credentials of 
your main Orion NCM server in the Orion Compatibility Checker.  

3. Click Next on the Welcome screen. 

4. Click I accept… and Next to accept the License Agreement.  

5. Click Next to accept the default location for installing the files or first use 
Browse to adjust the location. 

6. Click Next to start copying files. 

The software copies the files, including the Orion Core components needed 
for your server to communicate with the main Orin NCM server. 

7. Click Finish when the files are finished being copied. 

8. When  you are prompted to license the additional poller, click Enter 
Licensing Infromation and then complete the following procedure to license 
your installation: 

http://www.solarwinds.com/customerportal/
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a. If you have both an activation key and access to the internet, select 
the first option, I have internet access and an activation keyé, enter 
your Activation Key, and then click Next. 

Note: If you are using a proxy server to access the internet, check 
access your access toa the internet through a proxy server, and then 
provide the Proxy address and Port. 

b. If you do not have access to the internet from your designated 
Orion NCM additional poller host server, select This server does not 
have internet accessé, click Next, and then complete the steps 
provided.. 

You need a customer ID and password to successfully install the key. 
For more information, see the section “Obtaining a Software License 
Key”. 

9. Click Next on the Welcome screen of the SolarWinds Configuration Wizard. 

10. Specify the SQL Server instance—where the Orion Core database is 
located—and enter the authentication method (Windows or SQL Server 
Authentication) used to communicate with the instance. Click Next when you 
are ready. 

The SQL Server instance must support SQL authentication or mixed mode. 

Notes: 

¶ If you are using a local instance of SQL Server Express, use the 
following syntax to use the default instance: (local) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

11. Click Use an existing database, select the Orion Core database in the 
dropdown list, and then click Next.  

12. Click Use and existing account and select the account credentials from the 
dropdown list. Click Next when you are ready. 

13. Accept the default for Website Settings and click Next. 

14. Click Yes to acknowledge that the website already exists and that you want 
to proceed. 

15. Click Next after reviewing the services to install. 

16. Click Next after reviewing the Database, Website, and Services to be 
configured. 

The green progress bars and descriptive text explain what is being done and 
how far along it is. 
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17. Click Launch Orion Web and Finish to complete configuration and bring up 
the Orion Web Console. 

Repairing Orion Network Configuration Manager 

If your installation is behaving abnormally, you can repair it by launching the 
Configuration Wizard. Start it from the SolarWinds Orion Network Configuration 
Manager program group in the Start menu.  

Warning: If you install or make changes to Orion NCM Web, Configuration 
Wizard will reboot your IIS server, shutting down all SolarWinds products on the 
server during the configuration operation. Any websites hosted by the server will 
be stopped and restarted during this process. 

To repair Orion Network Configuration Manager: 

1. Launch Configuration Wizard. 

2. Select the components you want to repair or modify and click Next. 

3. Specify the appropriate SQL Server instance and the authentication method 
used to communicate with the instance, then click Next.  

The SQL Server instance must support SQL authentication or mixed mode. 

Notes: 

¶ If you are using a local instance of SQL Server Express, use the 
following syntax to use the default instance: (loc al) \ SQLEXPRESS. 

¶ If you select SQL Authentication, provide an account with sufficient rights 
to create new databases on the server instance. For example, specify 
the SQL administrator (sa) account. 

4. Select the existing Orion NCM database you want to use, and then click 
Next. 
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5. Create a new database account and password or select an existing account  
on the database server. 

Note: You must supply a strong password. For more information about 
strong passwords, see http://msdn.microsoft.com/en-
us/library/ms143705.aspx. 

6. If you need to specify a particular IP Address for your Orion NCM Web 
Console installation, provide the IP address you want to use for the Web 
Console. 

SolarWinds recommends that you retain the default IP address setting of All 
Unassigned unless your environment requires the designation of a specific 
IP address for your Orion Web Console. 

7. Specify both the port through which you want to access the Web Console 
and the volume and folder in which you want to install the Web Console files. 

If you accept the default port or you specify any port other than 80, you must 

include that port in the URL used to access the Web Console. For example, if 
you specify an IP address of 192.168.0.3  and port 8080, the URL used to 

access the Web Console is http://192.168.0.3:8 080. 

8. Click Next. I 

9. If you are prompted to use the existing website, click Yes. 

10. Review the services the wizard will install, and then click Next 

 Note: If you want to use the Trap Viewer tool or trigger realtime configuration 
change alerts based on traps, ensure the Windows SNMP Trap Service is 
running. If the SNMP Trap Service is not listed as a running service in the 

service control manager (services.msc ), you can enable Simple Network 

Management Protocol in the Management and Monitoring Tools through 
Add/Remove Windows Components in the Add/Remove Programs 
application.  

For more information, see “Error! Reference source not found.” on 
page Error! Bookmark not defined. and “Error! Reference source not 
found.” on page Error! Bookmark not defined.. 

11. Read the summary of what the configuration wizard will configure, and then 
click Next. 

12. Review the Configuration Summary, and then click Finish. 
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Using SSL Communication with Orion NCM 

Orion NCM supports the use of Secure Sockets Layer certificates to enable 
secure communications with the Orion NCM Web Console. The following 
procedure enables SSL connections to the Web Console.  

Notes: 

¶ Secure SSL communications are conducted over port 443.  

¶ The following procedure does not detail the process of either obtaining a 
required certificate or generating a certificate signing request for a third-party 
certificate authority. It is assumed that the required SSL certificate has 
already been installed on your Orion NCM server. For more information 
about acquiring and installing a required server certificate for SSL 
communications, see http://support.microsoft.com/kb/298805, from which this 
procedure was adapted.  

To enforce SSL connections to the Orion NCM Web Console:  

1. Log on as an administrator to your main Orion NCM server.  

2. Click Start > Control Panel > Administrative Tools > Computer 
Management.  

3. Expand Services and Applications > Internet Information Services (IIS) 
Manager > Web Sites.  

4. Right click SolarWinds NetPerfMon, then click Properties.  

5. Click the Web Site tab.  

6. Confirm that SSL port is set to 443, and then click Apply.  

7. Click Advanced.  

8. If the Multiple SSL identities for this Web site field does not list the IP 
address for the Orion Web Console with SSL port 443, complete the 
following steps:  

a. Click Add, and then select the IP address of the Orion Web Console.  

Note: As it was set initially in the Configuration Wizard, this option is 
usually set to (All Unassigned). If the IP address of the Orion Web 
Console was not initially set to (All Unassigned), select the actual, 
configured IP address of the Orion Web Console.  

b. Type 443 as the TCP port, and then click OK.  

9. Click the Directory Security tab.  

10. Click Edit in the Secure communications section.  

11. Check Require secure channel (SSL), and then click OK.  
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12. Click Apply, and then click OK to exit.  

Setting Node Communication Defaults 

A number of variables can be set globally and applied to all new nodes added to 
Orion NCM. Of course, when adding nodes, you can override the defaults. 

To set default node configuration parameters: 

1. Open the Orion NCM application  in the SolarWinds program group 
(SolarWinds Orion Network Configuration Manager > Orion Network 
Configuration Manager). 

2. Click File > Settings. 

3. Navigate to and expand Global Macro Settings. 

4. Select one of the following tree options and specify the appropriate default 
vaules: 

¶ Login Information 

¶ Transfer Protocols 

¶ Transfer Ports 

To override default settings for a particular node: 

1. Login to the Orion Web Console. 

2. Click Settings. 

3. Click Manage Nodes under Node & Group Management. 

4. Use the Group by list to organize the node list. 

5. Select the relevant node in the list. 

6. Click Edit Properties. 

7. Scroll down to NCM Properties. 

8. Edit the login and communication information.  

9. Click Submit. 
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Configuring Event Logging 

Logging events associated with a specific function of Orion Network 
Configuration Manager allows you to keep a detailed record of events and helps 
you troubleshoot any anomalies you may encounter. 

A number of functional areas within Orion NCM provide verbose logging options, 
including the following: 

Database Updates 

Logs database events, including backup and connectivity events. 

Inventory Monitor 

Logs inventory events, including SNMP timeouts, SNMP community string 
error messages, and status changes. 

Realtime Config Change Detection 

Logs relatime configuration change detection events, including change 
events, notification success and failure messages, and device connectivity 
events. 

Scheduled Jobs 

Logs scheduled job events, including time completed and individual item 
success or failure, for example, the failure to download an individual 
configuration file included in the job. 

Security 

Logs security events, including login failures, account modifications, and 
global security setting changes. 

To enable logging for Orion Network Configuration Manager events: 

1. Open the Orion NCM application  in the SolarWinds program group 
(SolarWinds Orion Network Configuration Manager > Orion Network 
Configuration Manager). 
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2. Click File > Settings. 

3. Click Advanced > Logging. 

4. Check the Orion Network Configuration Manager events you wish to monitor, 
and then click OK. 

Note: Logs are stored in the Logging folder found in your installation 

directory. By default, the Logging folder can be found in \ Program 

Files \ SolarWinds \ Configuration Management \ Logging \ . 

Moving Orion Network Configuration Manager 

The time necessary to move Orion Network Configuration Manager to a different 
computer depends on how long the database backup procedure takes. 
SolarWinds recommends scheduling an appropriate maintenance window to 
perform the migration procedure. 

Migration Requirements 

To move your Orion Network Configuration Manager installation to a new server, 
you will need the following items. 

¶ A computer meeting the minimum requirements for the new installation of 
Orion Network Configuration Manager.  

For more information on requirements, see “Requirements”. 

¶ User accounts with administrative rights on both servers. 

¶ You will need to reset your license using the License Manager. For more 
information, see “Resetting Your License” on page 57. 

¶ A temporary storage area for custom scripts and reports.  This can be any 
storage device able to hold the information and accessible from each Orion 
Network Configuration Manager computer; for example, a network drive 
accessible by each computer, a memory stick, or an external hard drive. 

Migrating Orion Network Configuration Manager 

Complete the following procedure to move Orion Network Configuration 
Manager. 

To move Orion Network Configuration Manager to another computer: 

1. Log on with an administrator account to your current Orion Network 
Configuration Manager. 

2. Close Orion Network Configuration Manager and any other running 
applications. 
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3. Open the Orion SQL Database Manager (SolarWinds Orion > Advanced 
Features > SQL Database Manager). 

4. If your SQL Server is not listed, add your server to the list. For more 
information, see “Error! Reference source not found.” on page Error! 
Bookmark not defined.. 

5. Click your Orion Network Configuration Manager database in the left pane of 
the Database Manager window, and then click Database > Backup 
Database. 

6. Type a description of the database backup and specify a path and filename 
for the backup file. Save your database backup to a temporary storage area. 
This can be a network drive accessible from each Orion Network 
Configuration Manager computer, a memory stick, or an external hard drive. 

Note: Ensure the target location for the database backup has sufficient 
available disk space. 

7. Click OK. 

8. Run License Manager to reset your current license, making it available for 
your new implementation. For more information, see “Using License 
Manager” on page 57. 

9. Log on to the new computer, and then install Orion Network 
Manager. For more information, see “Chapter 2 Installing Orion Network Configuration Manager” on page 6. 

10. Click Start > All Programs > SolarWinds Orion Network Configuration 
Manager > Orion Network Configuration Manager. 

11. Click File > New/Open Database Wizard. 

12. Review the Welcome window, and then click Next 

13. Click Open an Existing Database, and then click Next. 
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14. If you are using a SQL database, complete the following procedure: 

a. Click SQL Server Database. 

b. Select the appropriate authentication method and, if necessary, provide 
your user login credentials. 

c. Select your SQL Server from the list. 

d. Select your database from the list, and then click OK. 

e. Click Finished. 

Resetting Your License 

You can easily install the SolarWinds License Manager, a free utility that gives 
you the ability to easily migrate Orion licenses from one computer to another 
without contacting SolarWinds Customer Service. 

Note: You must install License Manager on a computer with the correct time. If 
the time on the computer is off 5 minutes, in either direction, from Greenwich 
Mean Time, you will be unable to reset licenses. Time zone settings do not affect 
and do not cause this issue. 

Installing License Manager 

Install License Manager on the computer from which you are migrating currently 
licensed products. 

To install License Manager: 

1. Click Start > All Programs > SolarWinds > SolarWinds License Manager 
Setup. 

2. Click I Accept to accept the SolarWinds EULA. 

3. Click Install. After installation completes, the program launches. For more 
information about using License Manager, see “Using License Manager” on 
page 57. 

Using License Manager 

You must run License Manager on the computer where the currently licensed 
SolarWinds product is installed. 

To deactivate currently installed licenses: 

1. Click Start > All Programs > SolarWinds > SolarWinds License Manager. 

2. Check the products you want to deactivate on this computer. 
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3. Click Deactivate. 

4. Specify your SolarWinds Customer ID and password when prompted, and 
then click Deactivate. 

Note: Deactivated licenses are now available for activation on a new 
computer. 

When you have successfully deactivated your products, log on to the computer 
on which you want to install your products and begin the installation procedure. 
When asked to specify your licenses, provide the appropriate information. The 
license you deactivated earlier is assigned to the new installation. 

Migrating Jobs 

If you are running any scheduled jobs, you will need to copy them to the new 
computer. Complete the following procedure to move your scheduled jobs. 

To move jobs to new hardware: 

1. Log on to the old computer. 

2. Copy the files in the Jobs  folder. By default, this folder is located at 

C: \ Program Files \ SolarWinds \ Orion \ NCM. 

3. Paste the files into the Jobs  folder on the new server. By default, this folder is 

located at C: \ Program Files \ SolarWinds \ Orion \ NCM. 

4. Click Start > All Programs > Accessories > Windows Explorer. 

5. Browse to My Computer > Control Panel > Scheduled Tasks. 

6. Select all of your Orion Network Configuration Manager jobs, and then click 
Edit > Copy. 

7. Paste the job files into the Scheduled Tasks  folder on the new server. By 

default, this folder is located at C: \ Program Files \ SolarWinds \ Orion \ NCM.  

Migrating Scripts 

If you have created any custom scripts, it will be necessary to copy them to the 
new computer. Complete the following procedure to move your scripts. 

To move scripts to new hardware: 

1. Log on to the old computer. 

2. Copy the files in the Scripts  folder. By default, this folder is located at 

C: \ Program Files \ SolarWinds \ Orion \ NCM. 

3. Paste the files into the Scripts  folder on the new server. By default, this 

folder is located at C: \ Program Files \ SolarWinds \ Orion \ NCM. 
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Migrating Reports 

If you have created any custom reports, it will be necessary to copy them to the 
new computer. Complete the following procedure to move your reports. 

To move reports to new hardware: 

1. Log on to the old computer. 

2. Copy the files in the Reports  folder. By default, this folder is located at 

C: \ Program Files \ SolarWinds \ Orion \ NCM. 

3. Paste the files into the Reports  folder on the new server. By default, this 

folder is located at C: \ Program Files \ SolarWinds \ Orion \ NCM. 

Migrating Device Command Templates 

If you have created any custom device command templates, it will be necessary 
to copy them to the new computer. Complete the following procedure to move 
your templates. 

To move device command templates to new hardware: 

1. Log on to the old computer. 

2. Copy the files in the DeviceTypes  folder. By default, this folder is located at 

C: \ Program Files \ SolarWinds \ Ori on\ NCM. 

3. Paste the files into the DeviceTypes  folder on the new server. By default, this 

folder is located at C: \ Program Files \ SolarWinds \ Orion \ NCM. 

 

 

 

 

 

 

 

 



 

 
60 Ö Getting Started 

Chapter 3 

Getting Started 

A significant amount of time spent managing your network devices can be cut 
using Orion Network Configuration Manager. The following section steps you 
through four common use cases. By stepping through this quick introduction, you 
learn how to add network devices, how to configure nightly backups, how to 
block private addresses on several devices, and how to update devices with a 
new community string. 

1. Adding network devices 

2. Configuring automated nightly backups 

3. Changing the community strings on multiple nodes 

4. Blocking a MAC address on a wireless access point 

Adding Nodes 

You can add nodes using the SolarWinds Network Sonar, add them individually, 
or import a list of nodes from a file. The following sections guide you through 
these methods: 

Adding Nodes with the Network Sonar Discovery 

SolarWinds Network Sonar Discovery is a high performance network discovery 
engine that allows you to build a database of the structure and devices found in 
your TCP/IP network. 

Note: To enable the integration of NCM with Orion reports, you must use 
Network Sonar Discovery to add nodes. 

To discover nodes: 

1. Log on to Orion Web Console. 

2. Click Settings. 

3. Click Network Sonar Discovery under Getting Started with Orion. 

4. If you want to create a new discovery, click Add New Discovery, click 
Add New Discovery.  

5. If you have already defined a network discovery, a number of options are 
available on the Network Sonar Discovery tab. Select one of the following: 

¶ If you want to edit an existing discovery before using it, select the 
discovery you want to edit, and then click Edit. 
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¶ If you want to use an existing discovery to rediscover your network, 
select the discovery you want to use, click Discover Now, and then 
complete the Network Sonar Results Wizard after discovery completes. 
For more information about network discovery results, see “Using the 
Network Sonar Results Wizard” on page 68. 

¶ If you want to import some or all devices found in a defined 
discovery that you may not have already imported for monitoring, 
select a currently defined discovery, and then click Import All Results. 
For more information about network discovery results, see “Using the 
Network Sonar Results Wizard” on page 68. 

¶ If you want to import any newly enabled devices matching a defined 
discovery profile, select a currently defined discovery, and then click 
Import New Results. For more information about network discovery 
results, see “Using the Network Sonar Results Wizard” on page 68. 

¶ If you want to delete an existing discovery profile, select a currently 
defined discovery and then click Delete. 

6. If the devices on your network do not require community strings other 

than the default strings public  and private  provided by Orion NCM, 
click Next on the SNMP Credentials view. 

7. If any of your network devices require community strings other than 

public  and private  or if you want to use an SNMPv3 credential, 

complete the following steps to add the required SNMP credential. 

Note: Repeat the following procedure for each new community string. To 
speed up discovery, highlight the most commonly used community strings on 
your network, and then use the arrows to move them to the top of the list.  

a. Click Add New Credential, and then select the SNMP Version of your 
new credential. 

b. If you are adding an SNMPv1 or SNMPv2c credential, provide the 
new SNMP Community String. 

c. If you are adding an SNMPv3 credential, provide the following 
information for the new credential: 

¶ User Name, Context, and Authentication Method 

¶ Authentication Password/Key, Privacy/Encryption Method and 
Password/Key, if required. 

d. Click Add. 

8. Click Next on the SNMP Credentials view. 



 

 
62 Ö Getting Started 

9. If you want to add Windows credentials for WMI collections, click Add 
New Credential.: 

a. Choose a credential. 

b. Name the credential. 

c. Enter the relevant user name (with privileges to accomplish WMI polling). 

d. Enter and confirm the user account password.  

e. Click Add. 

10. If you want to discover devices located on your network within a 
specific range of IP addresses, complete the following procedure. 

Note: Only one selection method may be used per defined discovery.  

a. Click IP Ranges in the Selection Method menu, and then, for each IP 
range, provide both a Start address and an End address. 

Note: Scheduled discovery profiles should not use IP address ranges 
that include nodes with dynamically assigned IP addresses (DHCP). 

b. If you want to add another range, click Add More, and then repeat the 
previous step. 

Note: If you have multiple ranges, click X to delete an incorrect range. 

c. If you have added all the IP ranges you want to poll, click Next. 

11. If you want to discover devices connected to a specific router or on a 
specific subnet of your network, complete the following procedure: 

Note: Only one selection method may be used per defined discovery.  

a. Click Subnets in the Selection Method menu. 

b. If you want to discover on a specific subnet, click Add a New 
Subnet, provide both a Subnet Address and a Subnet Mask for the 
desired subnet, and then click Add. 

Note: Repeat this step for each additional subnet you want to poll. 

c. If you want to discover devices using a seed router, click Add a 
Seed Router, provide the IP address of the Router, and then click Add. 

Notes: 

¶ Repeat this step for each additional seed router you want to use. 

¶ Network Sonar reads the routing table of the designated router and 
offers to discover nodes on the Class A network (255.0.0.0 mask) 
containing the seed router and, if you are discovering devices for an 
Orion NPM installation, the Class C networks (255.255.255.0 mask) 
containing all interfaces on the seed router, using the SNMP version 
chosen previously on the SNMP Credentials page. 
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¶ Networks connected through the seed router are NOT automatically 
selected for discovery. 

d. Confirm that all networks on which you want to conduct your network 
discovery are checked, and then click Next. 

12. If you already know the IP addresses or hostnames of the devices you 
want to discover and include in the Orion database, complete the 
following procedure: 

a. Click Specific Nodes in the Selection Method menu. 

b. Type the IPv4 addresses or hostnames of the devices you want to 
discover for monitoring into the provided field. 

Note: Type only one IPv4 address or hostname per line. 

c. Click Validate to confirm that the provided IPv4 addresses and 
hostnames are assigned to SNMP-enabled devices. 

d. If you have provided all the IPv4 addresses and hostnames you 
want to discover, click Next. 

13. Configure the options on the Discovery Settings view, as detailed in the 
following steps. 

a. Provide a Name and Description to distinguish the current discovery 
profile from other profiles you may use to discover other network areas. 

Note: This Description displays next to the Name in the list of available 
network discovery configurations on the Network Sonar view. 

b. Position the slider or type a value, in ms, to set the SNMP Timeout. 

Note: If you are encountering numerous SNMP timeouts during Network 
Discovery, increase the value for this setting. The SNMP Timeout should 
be at least a little more than double the time it takes a packet to travel 
the longest route between devices on your network. 

c. Position the slider or type a value, in ms, to set the Search Timeout. 

Note: The Search Timeout is the amount of time Network Sonar 
Discovery waits to determine if a given IP address has a network device 
assigned to it. 

d. Position the slider or type a value to set the number of SNMP Retries. 

Note: This value is the number of times Network Sonar Discovery will 
retry a failed SNMP request, defined as any SNMP request that does not 
receive a response within the SNMP Timeout defined above. 
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e. Position the slider or type a value to set the Hop Count. 

Note: If the Hop Count is greater than zero, Network Sonar Discovery 
searches for devices connected to any discovered device. Each 
connection to a discovered device counts as a hop. 

f. Position the slider or type a value to set the Discovery Timeout. 

Note: The Discovery Timeout is the amount of time, in minutes, Network 
Sonar Discovery is allowed to complete a network discovery. If a 
discovery takes longer than the Discovery Timeout, the discovery is 
terminated. 

14. If you only want to use SNMP to discover devices on your network, 
check Use SNMP only. 

Note: By default, Network Sonar uses ICMP ping  requests to locate devices. 

Most information about monitored network objects is obtained using SNMP 
queries. 

15. If multiple Orion polling engines are available in your environment, 
select the Polling Engine you want to use for this discovery. 

16. Click Next. 

17. If you want the discovery you are currently defining to run on a regular 
schedule, select either Custom or Daily as the discovery Frequency, as 
shown in the following steps: 

Notes: 

¶ Scheduled discovery profiles should not use IP address ranges that 
include nodes with dynamically assigned IP addresses (DHCP). 

¶ Default Discovery Scheduling settings execute a single discovery of your 
network that starts immediately, once you click Discover. 

¶ Results of scheduled discoveries are maintained on the Scheduled 
Discovery Results tab of Network Discovery. 

a. If you want to define a custom discovery schedule to perform the 
currently defined discovery repeatedly in the future, select Custom 
and then provide the period of time, in hours, between discoveries. 

b. If you want your scheduled discovery to run once daily, select Daily, 
and then provide the time at which you want your discovery to run every 
day, using the format HH:MM AM/PM. 

18. If you do not want to run your network discovery at this time, select No, 
donôt run now, and then click Save or Schedule, depending on whether you 
have configured the discovery to run once or on a schedule, respectively. 

19. If you want your Network Sonar discovery to run now, click Discover to 
start your network discovery. 
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Note: Because some devices may serve as both routers and switches, the 
total number of Nodes Discovered may be less than the sum of reported 
Routers Discovered plus reported Switches Discovered. 

Adding Individual Nodes 

 The following procedure details the steps required to add a device and its 
interfaces and volumes for monitoring in the Orion Web Console. 

To add a device for monitoring in the Orion Web Console: 

1. Log in to the Orion Web Console as an administrator. 

2. Click Settings in the top right of the web console. 

3. Click Manage Nodes in the Node Management grouping of the Orion 
Website Administration page. 

4. Click Add Node on the Node Management toolbar. 

5. Provide the hostname or IP Address of the node you want to add in the 
Hostname or IP Address field. 

6. If you only want to use ICMP to monitor node status, response time, or 
packet loss for the added node, check Status Only (ICMP). 

7. If you want to add an External node to monitor a hosted application 
with Orion products (for example, Orion APM), check External. 

Note: Orion NCM does not collect or monitor any network performance data 
from nodes designated as External. The External status is reserved for 
nodes hosting application that you want to monitor with Orion Application 
Performance Monitor. 

8. If you want to use SNMP to monitor the added node, confirm that ICMP 
(Ping only) is cleared, and then complete the following steps: 

a. Select the SNMP Version for the added node. 

Notes: 

¶ Orion NPM uses SNMPv2c by default. If the device you are adding 
supports or requires the enhanced security features of SNMPv3, 
select SNMPv3. 

¶ If SNMPv2c is enabled on a device you want Orion NCM to monitor, 
by default, Orion NCM will attempt to use SNMPv2c to poll for 
performance information. If you only want Orion NCM to poll using 
SNMPv1, you must disable SNMPv2c on the device to be polled. 

b. If the SNMP port on the added node is not the Orion product default 
of 161, provide the actual port number in the SNMP Port field. 
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c. If the added node supports 64 bit counters and you want to use 
them, check Allow 64 bit counters. 

Note: Orion products support the use of 64-bit counters; however, these 
high capacity counters can exhibit erratic behavior depending on 
manufacturer implementation. If you notice peculiar results when using 
these counters, use the Node Details view to disable the use of 64-bit 
counters for the device and contact the hardware manufacturer. 

9. If you want Orion products to use SNMPv2c to monitor the added node, 
provide valid community strings for the added node. 

Note: The Read/Write Community String is optional, but Orion products 

require the public  Community String, at minimum, for node monitoring. 

10. If you want Orion products to use SNMPv3 to monitor the added node, 
provide the following SNMP Credentials, Authentication, and 
Privacy/Encryption settings: 

¶ SNMPv3 Username and Context 

¶ SNMPv3 Authentication Method and Password/Key 

¶ SNMPv3 Privacy/Encryption Method and Password/Key 

11. If you are using SNMP to communicate with your added node, click 
Validate SNMP after entering all credentials to confirm your SNMP settings. 

12. Click Next. 

13. Check the interfaces, volumes, and interface charts for the added node that 
you want Orion to monitor. The following options are available in the 
selection toolbar: 

¶ Clicking All selects all listed devices and charts for monitoring. 

¶ Clicking None clears any checked interfaces, volumes, or interface 
charts that have been selected for monitoring. 

¶ Clicking All Active Interfaces selects only currently active interfaces 
and the associated interface charts for monitoring. 

¶ Clicking All Volumes selects all listed volumes for monitoring. 

¶ Clicking All Interfaces selects all listed interfaces for monitoring. 

14. After you have selected interfaces, volumes, or interface charts for 
monitoring, click Next. 
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15. If you want to edit the default polling settings for your added node, 
change the Node Status Polling or Collect Statistics Every values in the 
Polling area of the Change Properties page, as appropriate. 

Note: The Node Status Polling value refers to the number of seconds, 
between the node status checks Orion products perform on the added node. 
The Collect Statistics Every value refers to the period of time between the 
updates Orion products make to displayed statistics for the added node. 

16. If you have defined any custom properties for monitored nodes, provide 
appropriate values for the added node in the Custom Properties area of the 
Change Properties page. 

Note: The Custom Properties area is empty if you have not defined any 
custom properties for monitored nodes.. 

17. Click Add Node to NCM to manage the node as part of NCM. 

18. Click OK, Add Node when you have completed properties configuration. 

19. If you have successfully added the node, click OK on the dialog. 

20. Click .CONFIGS on the module bar. 

Adding and Managing NCM Nodes 

All Orion NCM nodes must also be managed in the Orion Core database, which 
all Orion products share. Use these procedures to add or remove Orion nodes to 
the NCM node list.  

To add a node or nodes to NCM: 

1. Log on to the Orion Web Console with an administrator account. 

2. Click Configs on the modules menu and click NCM Settings.  

3. Click Add or Manage Nodes in the NCM Node Management section. 

4. Use the Group by control to organize the list of Orion nodes. 

Consult the Licensed by NCM column to review the status of a given node. 

5. Click the Name(s) of the node(s) you want to license in NCM and then click 
Add  Nodes to NCM. 

To remove a node or nodes from NCM: 

1. Log on to the Orion Web Console with an administrator account. 

2. Click Configs on the modules menu and click NCM Settings.  

3. Click Add or Manage Nodes in the NCM Node Management section. 

4. Use the Group by control to organize the list of Orion nodes. 
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Consult the Licensed by NCM column to review the status of a given node. 

5. Click the Name(s) of the node(s) you want to delete from NCM and then click 
Remove  Nodes to NCM. 

Using the Network Sonar Discovery Results Wizard 

The Network Sonar Results Wizard directs you through the selection of network 
devices for monitoring, and it opens whenever discovery results are requested, 
either when the Network Sonar Discovery Wizard completes or when either 
Import All Results or Import New Results is clicked for a selected discovery. 

The following steps detail the selection of discovered objects for monitoring in 
Orion NCM. 

To select the results of a network discovery for monitoring in Orion NCM: 

1. On the Device Types to Import page, check the device types you want Orion 
NCM to monitor, and then click Next. 

Note: If you are not sure you want to monitor a specific device type, check 
the device type in question. If, later, you do not want to monitor a selected 
device, simply delete the device using Web Node Management. 

2. Check the interface types you want Orion NCM to monitor on the Interface 
Types to Import page, and then click Next. 

Note: If you are not sure you want to monitor a specific interface type, check 
the interface type in question. If, later, you do not want to monitor a selected 
interface, delete it using Web Node Management. 

3. On the Volume Types to Import page, check the volume types you want 
Orion NCM to monitor, and then click Next. 

Note: If you are not sure you want to monitor a specific volume type, check 
the volume type in question. If, later, you do not want to monitor any volume 
of the selected type, delete the volume using Web Node Management. 

4. Check valid states for imported interfaces and then click Next. 

Note: By default, Orion NCM imports interfaces that are discovered in an 
Operationally Up state. However, because interfaces may cycle off and on 
intermittently, the Import Settings page allows you to select interfaces found 
in Operationally Down or Shutdown states for import, as well. 

5. If there are any devices on the Import Preview that you do not ever want 
to import, check the device to ignore, and then click Ignore. Selected nodes 
are added to the Discovery Ignore List. 

6. Confirm that the network objects you want to monitor are checked on the 
Import Preview page, and then click Import. 
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7. After the import completes, click Finish. 

Note: Imported devices display in the All Nodes resource. 

Exploring the Orion Web Console 

The Orion Web Console, provided with Orion Network Configuration Manager, 
offers you access to your device configs without requiring physical access to your 
Orion NCM server. Through the Orion Web Console you gain flexibility and 
power. Provided you have the appropriate role, you can perform any of the 
following actions: 

¶ View configurations 

¶ Create and manage configuration policies 

¶ Update inventory 

¶ Check configuration backup status 

¶ Compare configurations and view differences 

¶ Download configurations 

¶ Upload configurations 

¶ Execute scripts on nodes 

¶ Create and manage config change templates 

Launching Orion Web Console 

To log on to the Orion Web Console, you can use either Windows credentials or 
an Orion credential set.  

To launch and login on the Orion Web Console: 

1. Click Orion Web Console in the SolarWinds Orion program group 
(SolarWinds Orion > Orion Web Console). 

2. Enter your Orion or Windows credentials. 

Understanding NCM Web Console Resources 

Each view within the Web Console provides a number of resources. The 
following sections are divided by the view on which NCM resources can be 
displayed. You can customize your views, adding and removing resources based 
on the account with which you Log on. For more information about customizing 
your views, see “Customizing the Orion Web Console”. 

HOME 
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The HOME views display resources shared by all Orion Core products. For more 
information about any of these resources, click Help on the resource in the Web 
Console. 

CONFIGS 

The CONFIGS views are Config Summary, Configuration Management, Conf 
Change Templates, Inventory, and Compliance.  

Config Summary 

The Config Summary view allows you to display the following resources. For 
more information about any of these resources, click Help on the resource in the 
Web Console. 

Pending Approval List 

Provides a list of requests submitted to change the config for specific network 
devices. 

Search NCM 

Enables you to perform text string searches on NCM nodes, whole or partial 
configs.  

All Nodes 

Provides an expandable and customizable list of the nodes which have been 
added to Orion NCM. Expanding groups, and then devices, allows you to 
reveal individual configurations. 

Devices Backed Up vs. Not Backed Up 

Provides a pie chart representing the percentage of backed up devices 
versus devices which have not been backed up over a specific period of 
time. 

Baseline vs. Running Config Conflicts 

Provides a pie chart representing the percentage of baseline configs versus 
running config conflicts over a specific period of time. 

Configurations Changes Snapshot 

Provides a pie chart representing the percentage of changed versus 
unchanged configurations over a specific period of time. 

Last XX Config Changes 

Provides a list of detected configuration changes, listing the user committing 
the change, the time of upload, and the type of configuration. 

Devices Backed Up vs. All Devices 
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Provides a pie chart designating the percentage of device that have been 
backed up using the Orion NCM application in comparison to those that have 
not been backed up. 

Most Recent Orion NCM Thwack Posts 

Provides an RSS feed driven list of the most recent Thwack posts for Orion 
NCM. 

Policy Report Violations 

Provides a stacked bar chart of status of your devices in relation to a specific 
policy report. 

Policy Violations 

Provides a list of the policy reports available and a brief overview of the 
contents of each report. 

Running vs. Startup Config Conflicts 

Provides a pie chart designating the percentage of devices running different 
configurations than their startup configurations. 

Devices Inventoried vs. Not Inventoried 

Provides a pie chart designating the percentage of devices inventoried in 
relation to those that have not. 

NCM Events 

Allows you to set a time period and see an overview of the Orion NCM 
events that occurred during that time period. 

Configuration Management 

The Configuration Management view allows you to display the following 
resources. For more information about any of these resources, click Help on the 
resource in the Web Console. 

View Changes 

Allows you to specify a time period and a node, and then display a change 
report that covers the set time range. 

Note: Consult this SolarWinds Orion NCM Knowledge Base article for 
special setup needed to ensure the accuracy of Config Change Reports 
based on a date range. 

Compare Selected Configs 

http://knowledgebase.solarwinds.com/kb/questions/2162/NCM+Requires+Special+Setup+to+Correctly+Report+on+Some+Config+Changes
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Allows you to select any two configurations to compare to one another. You 
can select configurations from the same device archived at different times, a 
startup versus a running configuration, or you can select configuration from 
differing devices. 

Compare to Baseline 

Allows you to select a single configuration to compare to a set baseline. You 
must set a baseline to use this feature. 

Download Config 

Allows you to select nodes and download running, startup, or custom 
configurations for those nodes. 

Execute Script 

Allows you to enter or load a script from a text file to execute against the 
nodes you select. 

Upload Config ï Multi Node 

Allows you to select a configuration you want to upload to multiple nodes. 

Upload Config ï Single Node 

Allows you to select a configuration you want to upload to the source node. 

Transfer Status 

Provides the most recent actions taken on a node. 

Config Change Templates 

The Config Change Templates view allows you to display the following 
resources. For more information about these resources, click Help. 

Config Change Templates 

Allows you to create, edit, import, export, tag, and delete config change 
templates. 

Shared Config Change Templates on thwack 

Allows you to view and download config change templates from thwack. 

Inventory 

The Inventory view allows you to view both the supplied inventory reports and 
those you have created with the Orion NCM application. Orion NCM provides 40 
unique inventory reports and allows you to create your own. 

Compliance 
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The Compliance view allows you to view both the supplied policy reports and 
those you have created with the Orion NCM application. Orion NCM provides 
numerous policy compliance tests, while also allowing you to create your own. To 
ensure you are viewing the most up-to-date information, click Update Now on 
the Compliance view. 

Searching 

The Advanced Search function allows you to search node properties, specific 
node configurations, all node configurations, and only the most recent 
downloaded configurations for specific text. You can also search within your 
search results. 

Customizing the Orion Web Console 

You can select the resource you want to display on a particular view. To do so, 
click Customize Page on the view you want to customize. You can then check 
the resources to include, drag-and-drop them from one column to another, or 
drag-and-drop them in a different order in the same column. Changes are saved 
as preferences associated with the logged on user account. 

Integrating SolarWinds Engineerôs Toolset 

When you are browsing the Orion Web Console from a computer that already 
has a SolarWinds Toolset installed, Orion NCM allows you to launch Toolset 
tools directly from your web browser. Right-clicking any monitored object listed in 
an Orion Web Console running the Toolset Integration displays a menu of 
available Toolset tools and functions. The following sections detail the 
configuration of the available Toolset integration. 

Note: For more information about the SolarWinds Engineer‟s Toolset tools, see 
www.solarwinds.com. 

Configuring a Toolset Integration 

The following procedure configures SolarWinds Toolset for integration within the 
Orion Web Console. 

Note: The first time the Toolset tools are accessed, a security warning may be 
displayed. Click Yes to allow the toolset integration. 

To configure SolarWinds Toolset integration settings: 

1. Right-click any monitored object displayed within the Orion Web Console. 

2. Click Settings. 

3. Click SNMP Community String. 
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Note: The first time you launch a tool requiring an SNMP community string 
from the right-click menu, the SNMP Community String window displays. 

4. If you want to delete any or all saved community strings, select the 
strings that you want to delete, and then click Remove, or click Remove All. 

5. Click Menu Options, and then configure the right-click menu as follows: 

a. If you want either to add menu items to the right-click menu or to 
remove menu items from the right-click menu, move menu items 
between the list of Available Menu Options on the left and Selected 
Menu Options on the right by selecting items in either column and 
clicking the right and left arrows, as appropriate. 

b. If you want to change the order of menu items, select items and then 
click the up and down arrows next to the Selected Menu Options list. 

c. If you want to add a separator between items, move the -------------- 
menu option from the Available list to the Selected list, and then move it 
to your preferred location within the Selected Menu Options list. 

6. Click Automatic Menu Items. 

7. Check either or both, if available, of the following options: 

¶ Automatically add sub-menu items to the ñMIB Browser (Query 
MIB)ò menu option from the MIB Browerôs Bookmarks. 

¶ Automatically add sub-menu items to the ñReal Time Interface 
Monitorò menu option from the Real-Time Interface Monitor saved 
report types. 

Note: These options expand the list of available menu items by incorporating 
menu links to MIB browser bookmarks and Real-time Interface Monitor saved 
reports, respectively. 

Adding Programs to a Toolset Integration Menu 

The following procedure provides the steps required to add any external scripts 
or applications to the SolarWinds Toolset integration menu. 

To add a program to the SolarWinds Toolset Integration menu: 

1. If you want to add an external script to the Toolset Integration menu, 
save the script in an appropriate location on the install volume of your Orion 

server (e.g. <InstallVolume >: \ \ Scripts \ ). 

2. If you want to add an external application to the Toolset Integration 
menu, install the application in an appropriate location on the install volume 

of your Orion server (e.g. <InstallVolume >: \ \ Application \ ). 

3. Open SWToolset. MenuOptions  in a text editor. 



 

 
Getting Started Ö 75 

Note: By default, SWToolset.Me nuOptions  is located in the following folder: 

<InstallVolume >: \ \ <LocalApplicationData >\ SolarWinds \ Common\ , 

where <LocalApplicationData > for the current Windows user is 

<ProfileFolder >\ LocalSettings \ Application Data . 

4. Save a copy of SWToolset. MenuOptions  as SWToolset _Old . MenuOptions . 

5. Add the following line between the <MenuOptions>< / MenuOptions>  tags of 

the SWToolset. MenuOptions  file: 

<MenuOption Visible="TRUE" Title=" Applicat ionName " 

BeginGroup="FALSE" HasSubMenu="FALSE" 

ExecString=" <InstallVolume >: \ \ Application \ ExecutableFile " 

Icon="" Extra="" Parent="" Required="4"/>  

Note: The string supplied for Title  is the name for the added script or 

application that will display in the menu. The string supplied for the 
ExecString  is the path to the script or application executable file.  

6. Save the new SWToolset. MenuOptions  to automatically update the Toolset 

Integration menu. 

Configuring Automated Nightly Backups 

A powerful feature of Orion Network Configuration Manager is the ability to 
schedule daily configuration file backups. Orion Network Configuration Manager 
ships with an example job which downloads the configuration files nightly for all 
nodes in the database. You can modify the example for your specific needs, or 
you can create a new job. The following procedure creates a new nightly 
configuration backup job. 

To setup nightly configuration backups for all nodes: 

1. Open the Orion Network Configuration Manager application. 

2. Click Schedule > Create New Job. 

3. Click Download Configs from Devices, and then click Next. 

4. Type a name for the job, and then click Continue. 

5. Select Daily in the Schedule Job list. 

6. Type or select a time in the Start Time field. 

7. Type or select a date in the Starting On field. 

8. Type or select a date in the Ending On field. To assign a job to run with no 
end date, leave this field blank. 

9. Click Continue. 

10. Type the Windows account name that will be used to run the job. 
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11. Type the password for the Windows account in the appropriate password 
fields. 

12. Click Finish. 

13. Type any comments in the Comments field. 

14. Click the Download Config tab. 

15. Check the configuration types you want to download. 

16. Check Last Config to be notified when the downloaded configuration file is 
different from the last configuration. 

17. Check Baseline Config to be notified when the downloaded configuration 
file is different from the baseline configuration. 

18. Click OK. 

Changing the Community String on Multiple Nodes 

The following procedure replaces the public  read-only community string with a 
new read-only community string on several network nodes at the same time. 

To update the community string for a group of nodes: 

1. Back up the running configuration prior to making any changes.  

2. Click the node or group of nodes you want to update, and then click Nodes > 
Download Configs. 

3. Click Download. 

4. Right-click a node or group of nodes, and then click Execute Command 
Script. 

5. Type the following command script: 

config t  

no snmp - server community public RO  

snmp- server community 123@dm1n RO  

exit  

wr mem 

Where 123@dm1n is the new community string. 

6. Click Execute Command Script. 
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7. To verify that the script executed successfully, 

a. Click the node or group of nodes you updated, and then click Nodes > 
Download Configs. 

b. Check Compare to last Config Downloaded. 

c. Click Download. When the download completes, a comparison window 
opens. Changes to the community string are highlighted in red and 
green. 

Blocking a MAC Address on a Wireless Access Point 

If you discover a device utilizing unauthorized access to your wireless network, 
you can block the MAC address to prevent future access. The following 
procedure uses an access control list (ACL) on a wireless access point to block a 
specific MAC address. 

To update the ACL for a node: 

1. Back up the running configuration prior to making any changes. 

2. Click the group of routers that are to be updated, and then click Nodes > 
Download Configs. 

3. Click Download. 

4. Click the group of routers that you want to update, and then click Nodes > 
Execute Command Script. 

5. Type the following command script: 

${EnterConfigMode}  

access - list 724 deny 000e.0ca1.a2b4 0000.0000.0000  

exit  

wr mem  

Where 724  is the ACL you are modifying, and where 000E.0CA1.A2B4  is the 

MAC address to block. ${EnterConfigMode}  is a variable that is equivalent 

to Config Terminal  on Cisco devices. 

6. Verify the script executed successfully by completing the following 
procedure: 

a. Click the node or group of nodes, and then click Download Configs. 

b. Check Compare to last Config Downloaded. 

c. Click Download. 

d. When the download completes, a comparison window opens 
automatically. Changes to the access list are highlighted in red and 
green. 
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